AmpFSTR® Yfiler® PCR Amplification Kit

for use with:
100 reaction kit (Part no. 4359513)

Publication Number 4358101
Revision J
For Forensic or Paternity Use Only.

Information in this document is subject to change without notice.

DISCLAIMER: LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. TO THE EXTENT ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

TRADEMARKS

© 2014 Thermo Fisher Scientific Inc. All rights reserved. All other trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.

Life Technologies is a Thermo Fisher Scientific Brand.

TaqMan and AmpliTaq Gold are registered trademarks of Roche Molecular Systems, Inc. TaqMan is used under permission and license.

Microsoft, Windows and Windows Vista are registered trademarks of Microsoft Corporation.

Minitab is a registered trademark of Minitab, Inc.

Mac OS is a registered trademark of Apple, Inc.
Contents

About This Guide .......................................................... 9
Revision history ............................................................. 9
Purpose .......................................................................... 9

CHAPTER 1  Overview ..................................................... 11
Product overview .......................................................... 11
  Purpose ...................................................................... 11
  Product description ...................................................... 11
  About the primers ........................................................ 11
  Loci amplified by the kit .................................................. 12
  Allelic ladder profile ...................................................... 12
  Control DNA 007 profile ............................................... 14
Workflow overview .......................................................... 15
Instrument and software overview ........................................ 16
  Data Collection and GeneMapper® ID or ID-X Software .......... 16
  Instrument and software compatibility ................................ 16
  About multicomponent analysis ....................................... 16
  How multicomponent analysis works ................................. 16
Materials and equipment .................................................. 18
  Kit contents and storage ................................................. 18
  Standards for samples .................................................... 18

CHAPTER 2  Perform PCR ................................................ 19
Required user-supplied reagents ........................................... 19
DNA quantification .......................................................... 19
  Importance of quantification .......................................... 19
  Methods of quantifying DNA ......................................... 20
Prepare the amplification kit reactions ..................................... 21
Perform PCR .................................................................. 22

CHAPTER 3  Perform Electrophoresis ................................. 23
Allelic ladder requirements ................................................ 23
Section 3.1 3100/3100-Avant and 3130/3130xl instruments ........... 25
Set up the 3100/3100-Avant or 3130/3130xl instrument for electrophoresis ............................................. 25
  Reagents and parts ......................................................... 25
  Electrophoresis software setup and reference documents ......... 25
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xl instrument ................................. 26
CHAPTER 4 Analyze Data ............................................. 31
Section 4.1 GeneMapper® ID Software ................................. 31
Overview of GeneMapper® ID Software ............................... 31
  Instruments ................................................................... 31
  Before you start .......................................................... 32
Set up GeneMapper® ID Software for data analysis ................... 32
  File names .................................................................. 32
  Before using the software for the first time ......................... 32
  Import panels and bins ................................................. 33
  Create an analysis method .......................................... 37
  General tab settings .................................................. 38
  Allele tab settings ...................................................... 39
  Peak Detector tab settings ......................................... 40
  Peak Quality tab settings ......................................... 41
  Quality Flags tab settings ....................................... 42
  Create size standard .................................................. 42
Analyze and edit sample files with GeneMapper® ID Software ...... 44
Examine and edit a project ............................................... 45
For more information .................................................. 46
Section 4.2 GeneMapper® ID-X Software .............................. 48
Overview of GeneMapper® ID-X Software ............................ 48
  Instruments ................................................................ 48
  Before you start ........................................................ 48
Set up GeneMapper® ID-X Software for data analysis .............. 49
  Panel, bin, and stutter file version ............................... 49
  Before using the software for the first time ..................... 49
  For more information ............................................... 49
  Check panel, bin, and stutter file version ......................... 50
  Import panels, bins, and marker stutter ......................... 50
  Create an analysis method ....................................... 55
  General tab settings .................................................. 56
CHAPTER 5 Experiments and Results

Section 5.1 Developmental Validation

Overview
Importance of validation
Experiment conditions
Developmental validation
SWGDAM Guideline 1.2.1
SWGDAM Guideline 2.1.0.1
PCR components
Thermal cycler parameters
PCR cycle number
Accuracy, precision, and reproducibility
SWGDAM Guideline 2.9
Precision and size windows
Extra Peaks in the electropherogram
Causes of extra peaks
Stutter products
Addition of 3’ A
Artifacts
Characterization of loci
SWGDAM Guideline 2.1
Nature of the polymorphisms
Inheritance
Mapping
Species specificity
SWGDAM Guideline 2.2
Sensitivity
SWGDAM Guideline 2.3
Effect of DNA quantity on results and importance of quantitation
Stability
SWGDAM Guideline 2.4
Lack of amplification of some loci
Effect of inhibitors
Degraded DNA
Mixture studies ................................................................. 86
   SWGDAM Guideline 2.8 .................................................. 86
   Male/female mixture studies ........................................... 86
   Male/male mixture studies ............................................. 87
Population data .............................................................. 88
   SWGDAM Guideline 2.7 .................................................. 88
   Overview ........................................................................ 88
   Population samples used in these studies ........................... 89
   Gene diversity values ..................................................... 89
   Analyzing the population data ........................................... 89
Mutation rate ................................................................. 90

Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement ................................. 92
   Overview ........................................................................ 92
   Experiments .................................................................... 92
   Reproducibility study .................................................... 93
      Intracolor balance ....................................................... 93
      Stutter percentages .................................................... 93
      Artifacts ...................................................................... 94
   Sensitivity study ............................................................ 95
      Mean referenced peak height ...................................... 95
      DNA concentration and peak height .............................. 96
      Allelic dropout .......................................................... 96
      Genotype concordance ............................................... 98
   Inhibition study ............................................................ 98
      Mean referenced peak height, minimum referenced peak height, and intracolor balance . 98
      Allelic dropout .......................................................... 101
Conclusions ...................................................................... 101

APPENDIX A Troubleshooting .................................................. 103

APPENDIX B Ordering Information ........................................... 105
   Equipment and materials not included .............................. 105

APPENDIX C PCR Work Areas .............................................. 109
   Work area setup and lab design ....................................... 109
   PCR setup work area .................................................... 109
   Amplified DNA work area ............................................. 110

APPENDIX D Safety ............................................................ 111
   Chemical safety .......................................................... 112
   Biological hazard safety ............................................... 112
About This Guide

IMPORTANT! Before using this product, read and understand the information the “Safety” appendix in this document.

Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>November 2004</td>
<td>New document.</td>
</tr>
<tr>
<td>B</td>
<td>June 2005</td>
<td>—</td>
</tr>
<tr>
<td>C</td>
<td>August 2006</td>
<td>—</td>
</tr>
<tr>
<td>D</td>
<td>September 2010</td>
<td>—</td>
</tr>
<tr>
<td>E</td>
<td>April 2011</td>
<td>Change to limited licensing information.</td>
</tr>
<tr>
<td>F</td>
<td>March 2012</td>
<td>Change to limited licensing information.</td>
</tr>
<tr>
<td>G</td>
<td>August 2012</td>
<td>• Remove Mac OS® procedures.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add 3100, 3100-Avant, 3130, 3130xL, 3500, 3500xL Genetic Analyzer information. Added GeneMapper® ID Software and GeneMapper® ID-X Software information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add validation experiments and results for buffer and enzyme kit component changes.</td>
</tr>
<tr>
<td>H</td>
<td>September 2012</td>
<td>Correct PCR final extension time error in rev G.</td>
</tr>
<tr>
<td>J</td>
<td>April 2014</td>
<td>Change the number of PCR cycles from 28 to 30 on page 19.</td>
</tr>
</tbody>
</table>

Purpose

The AmpFSTR® Yfiler® PCR Amplification Kit User Guide provides information about the Life Technologies instruments, chemistries, and software associated with the AmpFSTR® Yfiler® PCR Amplification Kit.
Product overview

Purpose
The AmpFlSTR® Yfiler® PCR Amplification Kit is a short tandem repeat (STR) multiplex assay that amplifies 17 Y-STR loci in a single PCR amplification:

- “European minimal haplotype” (DYS19, DYS385a/b, DYS389I/II, DYS390, DYS391, DYS392, DYS393).
- Scientific Working Group-DNA Analysis Methods (SWGDAM)-recommended Y-STR panel (European minimal haplotype plus DYS438 and DYS439).
- Additional highly polymorphic loci: DYS437, DYS448, DYS456, DYS458, DYS635 (Y GATA C4), and Y GATA H4.

Product description
The Yfiler® Kit contains all the necessary reagents for the amplification of human male-specific genomic DNA.

The reagents are designed for use with the following Life Technologies instruments:

- Applied Biosystems® 3100/3100-Avant Genetic Analyzer
- Applied Biosystems® 3130/3130xl Genetic Analyzer
- Applied Biosystems® 3500/3500xL Genetic Analyzer
- 310 Genetic Analyzer
- GeneAmp® PCR System 9700 with the Silver 96-Well Block
- GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
- Veriti® 96-Well Thermal Cycler

About the primers
Non-nucleotide linkers are used in primer synthesis for the DYS438 and DYS456 loci. For these primers, non-nucleotide linkers are placed between the primers and the fluorescent dye during oligonucleotide synthesis (Butler, 2005, Grossman et al., 1994, and Baron et al., 1996). Non-nucleotide linkers enable reproducible positioning of the alleles to facilitate interlocus spacing. The combination of a five-dye fluorescent system and the inclusion of non-nucleotide linkers allows for simultaneous amplification and efficient separation of the 17 Y-STR loci during automated DNA fragment analysis.
### Loci amplified by the kit

The following table shows the loci amplified, their chromosomal locations, and the corresponding fluorescent marker dyes. The AmpF/STR® Yfiler® Allelic Ladder is used to genotype the analyzed samples. The alleles contained in the allelic ladder and the genotype of the AmpF/STR® Control DNA 007 are also listed in the table.

Table 1  Yfiler® Kit loci and alleles

<table>
<thead>
<tr>
<th>Locus designation</th>
<th>Alleles included in AmpF/STR® Yfiler® Allelic Ladder</th>
<th>Dye label</th>
<th>Control DNA 007</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS456</td>
<td>13, 14, 15, 16, 17, 18</td>
<td>6-FAM™</td>
<td>15</td>
</tr>
<tr>
<td>DYS389 I</td>
<td>10, 11, 12, 13, 14, 15</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>DYS390</td>
<td>18, 19, 20, 21, 22, 23, 24, 25, 26, 27</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>DYS389 II</td>
<td>24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td>DYS458</td>
<td>14, 15, 16, 17, 18, 19, 20</td>
<td>VIC®</td>
<td>17</td>
</tr>
<tr>
<td>DYS19</td>
<td>10, 11, 12, 13, 14, 15, 16, 17, 18, 19</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>DYS385 a/b</td>
<td>7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25</td>
<td>11,14</td>
<td></td>
</tr>
<tr>
<td>DYS393</td>
<td>8, 9, 10, 11, 12, 13, 14, 15, 16</td>
<td>NED™</td>
<td>13</td>
</tr>
<tr>
<td>DYS391</td>
<td>7, 8, 9, 10, 11, 12, 13</td>
<td></td>
<td>11</td>
</tr>
<tr>
<td>DYS439</td>
<td>8, 9, 10, 11, 12, 13, 14, 15</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>DYS635</td>
<td>20, 21, 22, 23, 24, 25, 26</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>DYS392</td>
<td>7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Y GATA H4</td>
<td>8, 9, 10, 11, 12, 13</td>
<td>PET®</td>
<td>13</td>
</tr>
<tr>
<td>DYS437</td>
<td>13, 14, 15, 16, 17</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>DYS438</td>
<td>8, 9, 10, 11, 12, 13</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>DYS448</td>
<td>17, 18, 19, 20, 21, 22, 23, 24</td>
<td>19</td>
<td></td>
</tr>
</tbody>
</table>

### Allelic ladder profile

Figure 1 shows the allelic ladder for the Yfiler® Kit. See “Allelic ladder requirements” on page 23 for information on ensuring accurate genotyping.
Figure 1  GeneMapper® ID-X Software plot of the AmpFISTR® Yfiler® Allelic Ladder
Control DNA 007 profile

Figure 2 shows amplification of Control DNA 007 using the Yfiler® Kit.

Figure 2 1 ng of Control DNA 007 amplified with the Yfiler® Kit and analyzed on the Applied Biosystems® 3130xl Genetic Analyzer.
Workflow overview

**Perform PCR**
- Extract DNA
  - AutoMate Express™ System + PrepFiler® Express Kit

**Quantify DNA**
- Quantifiler® Duo DNA Quantification Kit

**Prepare reactions**
- AmpFISTR® Yfiler® PCR Amplification Kit

**Perform PCR**
- GeneAmp® PCR System 9700 Cycler
- Veriti® 96-Well Thermal Cycler

**Perform electrophoresis**
- 3100/3100-Avant Genetic Analyzer
- 3130/3130xl Genetic Analyzer
- 3500/3500xL Genetic Analyzer
- 310 Genetic Analyzer

**Analyze data**
- GeneMapper® ID-X or GeneMapper® ID Software
Overview

Instrument and software overview

This section provides information about the Data Collection Software versions required to run the AmpFISTR® Yfiler® PCR Amplification Kit on specific instruments.

Data Collection and GeneMapper® ID or ID-X Software

The Data Collection Software provides instructions to firmware running on the instrument and displays instrument status and raw data in real time. As the instrument measures sample fluorescence with its detection system, the Data Collection Software collects the data and stores it. The Data Collection Software stores information about each sample in a sample file (.fsa), which is then analyzed by the GeneMapper® ID or ID-X Software.

Table 2 Software specific to each instrument

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Operating system</th>
<th>Data Collection Software</th>
<th>Analysis software</th>
</tr>
</thead>
</table>
| 3500/3500xL | • Windows® XP  
• Windows Vista® | 3500 Series Data Collection Software v1.0 | GeneMapper® ID-X Software v1.2 or higher |
| 3100/3100-Avant | Windows® XP | 3.0 | • GeneMapper® ID Software v3.2.1  
and  
• GeneMapper® ID-X Software v1.0.1 or higher |
| 3100†/3100-Avant | Windows® NT  
Windows® 2000 | 1.1 (3100)  
1.0 (3100-Avant)  
2.0 | |
| 310 | Windows® XP  
• Windows® NT  
• Windows® 2000 | 3.1  
3.0 | |

† We conducted validation studies using these configurations.

About multicomponent analysis

Life Technologies fluorescent multi-color dye technology allows the analysis of multiple loci, including loci that have alleles with overlapping size ranges. Alleles for overlapping loci are distinguished by labeling locus-specific primers with different colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent dye colors into distinct spectral components. The four dyes used in the Yfiler® Kit to label samples are 6-FAM™, VIC®, NED™, and PET® dyes. The fifth dye, LIZ® dye, is used to label the GeneScan™ 500 LIZ® Size Standard or the GeneScan™ 600 LIZ® Size Standard v2.0.

How multicomponent analysis works

Each of these fluorescent dyes emits its maximum fluorescence at a different wavelength. During data collection on the Life Technologies instruments, the fluorescence signals are separated by diffraction grating according to their wavelengths and projected onto a charge-coupled device (CCD) camera in a predictably spaced pattern. The 6-FAM™ dye emits at the shortest wavelength and it is displayed as blue, followed by the VIC® dye (green), NED™ dye (yellow), PET® dye (red), and LIZ® dye (orange).
Although each of these dyes emits its maximum fluorescence at a different wavelength, there is some overlap in the emission spectra between the dyes (Figure 3). The goal of multicomponent analysis is to correct for spectral overlap.

**Figure 3**  Emission spectra of the five dyes used in the AmpFISTR® Yfiler® Kit
Materials and equipment

Kit contents and storage

The AmpFSTR® Yfiler® PCR Amplification Kit (Part no. 4427368) contains materials sufficient to perform 100 amplifications at 25 µL/amplification.

**IMPORTANT!** The fluorescent dyes attached to the primers are light sensitive. Protect the primer set, amplified DNA, allelic ladder, and size standard from light when not in use. Keep freeze-thaw cycles to a minimum.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>100× Volume</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>AmpFSTR® Yfiler® PCR Reaction Mix</td>
<td>Contains MgCl₂, dNTPs, and bovine serum albumin in buffer with 0.05% sodium azide.</td>
<td>1 tube, 1.1 mL</td>
<td>−15 to −25°C on receipt, 2 to 8°C after initial use</td>
</tr>
<tr>
<td>AmpFSTR® Yfiler® Primer Set</td>
<td>Contains forward and reverse primers to amplify human male DNA target.</td>
<td>1 tube, 0.55 mL</td>
<td></td>
</tr>
<tr>
<td>AmpFSTR® Yfiler® Allelic Ladder</td>
<td>Contains amplified alleles. See Table 1 on page 12 for a list of alleles included in the allelic ladder.</td>
<td>1 tube, 0.05 mL</td>
<td></td>
</tr>
<tr>
<td>AmpFSTR® Control DNA 007</td>
<td>Contains 0.10 ng/µL human male DNA in 0.05% sodium azide and buffer†. See Table 1 on page 12 for profile.</td>
<td>1 tube, 0.3 mL</td>
<td></td>
</tr>
<tr>
<td>AmpFSTR® Control DNA 9947A</td>
<td>Contains 10 ng/µL human female DNA in 0.05% sodium azide and buffer. See Table 1 on page 12 for profile.</td>
<td>1 tube, 0.025 mL</td>
<td></td>
</tr>
<tr>
<td>AmpliTaq Gold® DNA Polymerase</td>
<td>Contains enzyme, with an activity of 5 U/µL. 2 tubes, 0.05 mL each</td>
<td></td>
<td>−15 to −25°C</td>
</tr>
</tbody>
</table>

†The AmpFSTR® Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control (i.e., to provide confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpFSTR® Control DNA 007 is not designed to be used as a DNA quantitation control, and you may see variation from the labelled concentration when quantitating aliquots of the AmpFSTR® Control DNA 007.

Standards for samples

For the Yfiler® Kit, the panel of standards needed for PCR amplification, PCR product sizing, and genotyping are:

- **AmpFSTR® Control DNA 007** – A positive control for evaluating the efficiency of the amplification step and STR genotyping using the AmpFSTR® Yfiler® Allelic Ladder.

- **GeneScan™ 500 LIZ® Size Standard or GeneScan™ 600 LIZ® Size Standard v2.0** – Used for obtaining sizing results. These standards, which have been evaluated as internal size standards, yield precise sizing results for Yfiler® Kit PCR products. Order the GeneScan™ 500 LIZ® Size Standard (Part no. 4322682) or the GeneScan™ 600 LIZ® Size Standard v2.0 (Part no. 4408399) separately.

- **AmpFSTR® Yfiler® Allelic Ladder** – Allelic ladder developed by Life Technologies for accurate characterization of the alleles amplified by the Yfiler® Kit. The AmpFSTR® Yfiler® Allelic Ladder contains most of the alleles reported for the 17 loci. Refer to Table 1 on page 12 for a list of the alleles included in the AmpFSTR® Yfiler® Allelic Ladder.
Perform PCR

Required user-supplied reagents

In addition to the Yfiler® Kit reagents, the use of low-TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as described in the procedure below or order it from Teknova (Cat # T0223).

To prepare low-TE buffer:

1. Mix together:
   - 10 mL of 1 M Tris-HCl, pH 8.0
   - 0.2 mL of 0.5 M EDTA, pH 8.0
   - 990 mL glass-distilled or deionized water

   Note: Adjust the volumes accordingly for specific needs.

2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Quantifying the amount of DNA in a sample before amplification allows you to determine whether or not sufficient DNA is present to permit amplification and to calculate the optimum amount of DNA to add to the reaction. The optimum amount of DNA for the Yfiler® Kit is 1.0 ng in a maximum input volume of 10 µL for 30 PCR cycles.
Perform PCR

DNA quantification

If too much DNA is added to the PCR reaction, then the increased amount of PCR product that is generated can result in:

- Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument ("off-scale" data). Off-scale data are problematic because:
  - Quantitation (peak height and area) for off-scale peaks is not accurate. For example, an allele peak that is off-scale can cause the corresponding stutter peak to appear higher in relative intensity, thus increasing the calculated percent stutter.
  - Multicomponent analysis of off-scale data is not accurate, and it results in poor spectral separation ("pull-up").
- Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic dropout can occur resulting in a partial profile.

Methods of quantifying DNA

Life Technologies provides several kits for quantifying DNA in samples. See the references cited in the following table for details about these kits.

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler® Human DNA Quantification Kit</td>
<td>Properties: The Quantifiler® Human and Quantifiler® Y Human Male Kits are highly specific for human DNA, and they individually detect total human or male DNA, respectively. The kits detect single-stranded and degraded DNA. How they work: The Quantifiler® DNA Quantification Kits consist of target-specific and internal control 5' nuclease assays. The Quantifiler® Human and Quantifiler® Y Human Male Kits contain different target-specific assays (human DNA or human male DNA, respectively) that each consist of two locus-specific PCR primers and one TaqMan® MGB probe labeled with FAM™ dye for detecting the amplified sequence. The kits each contain a separate internal PCR control (IPC) assay, which consists of an IPC template DNA (a synthetic sequence not found in nature), two primers for amplifying the IPC template, and one TaqMan® MGB probe labeled with VIC® dye for detecting the amplified IPC.</td>
</tr>
<tr>
<td>Part no. 4343895</td>
<td>For more information, see Quantifiler® Human DNA Quantification Kits User’s Manual (Pub no. 4344790)</td>
</tr>
<tr>
<td>and Quantifiler® Y Human Male DNA Quantification Kit</td>
<td></td>
</tr>
<tr>
<td>Part no. 4343906</td>
<td>Properties: The Quantifiler® Duo Kit is highly specific for human DNA. This kit combines the detection of both total human and male DNA in one PCR reaction. The kit detects single-stranded and degraded DNA. How it works: The Quantifiler® Duo DNA Quantification Kit consists of target-specific and internal control 5' nuclease assays. The Quantifiler® Duo kit combines two human-specific assays in one PCR reaction (for total human DNA and human male DNA). The two human DNA specific assays each consist of two PCR primers and a TaqMan™ probe. The TaqMan® probes for the human DNA and human male DNA assays are labeled with VIC® and FAM™ dyes, respectively. In addition, the kit contains an internal PCR control (IPC) assay similar in principle to that used in the other Quantifiler kits, but labeled with NED™ dye.</td>
</tr>
<tr>
<td>Part no. 4387746</td>
<td>For more information, see Quantifiler® Duo DNA Quantification Kit User’s Manual (Part no.4391294)</td>
</tr>
</tbody>
</table>

AmpFISTR® Yfiler® PCR Amplification Kit User Guide
Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using the table below.

<table>
<thead>
<tr>
<th>DNA sample</th>
<th>Volume per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>AmpFISTR® PCR Reaction Mix</td>
<td>9.2 µL</td>
</tr>
<tr>
<td>AmpFISTR® Yfiler® Primer Set</td>
<td>5.0 µL</td>
</tr>
<tr>
<td>AmpliTaq Gold® DNA Polymerase</td>
<td>0.8 µL</td>
</tr>
</tbody>
</table>

2. Prepare reagents. Include additional reactions in your calculations to provide excess volume for the loss that occurs during reagent transfers. Thaw the PCR Reaction Mix and the Primer Set, then vortex all reagent tubes, including the enzyme, for 3 seconds and centrifuge briefly before opening the tubes.

**IMPORTANT!** Thawing is required only during first use of the Primer Set and PCR Reaction Mix. After first use, these reagents are stored at 2 to 8°C and, therefore, they do not require subsequent thawing. Do not refreeze these reagents.

3. Prepare the master mix: Pipette the required volumes of components into an appropriately sized polypropylene tube.

4. Vortex the master mix for 3 seconds, then centrifuge briefly.

5. Dispense 15 µL of the master mix into each reaction well of a MicroAmp® Optical 96-Well Reaction Plate or each MicroAmp® tube.

6. Prepare the DNA samples:

<table>
<thead>
<tr>
<th>DNA sample</th>
<th>To prepare...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative control</td>
<td>Add 10 µL of low-TE buffer [10mM Tris, 0.1mM EDTA, pH 8.0].</td>
</tr>
<tr>
<td>Test sample</td>
<td>Dilute a portion of the test DNA sample with low-TE buffer so that 1.0 ng of total DNA is in a final volume of 10 µL. Add 10 µL of the diluted sample to the reaction mix.</td>
</tr>
<tr>
<td>Positive control</td>
<td>Add 10 µL of 007 control DNA [0.1 ng/µL].</td>
</tr>
</tbody>
</table>

The final reaction volume (sample or control plus master mix) is 25 µL.

7. Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical Adhesive Film, or cap the tubes.

8. Centrifuge the tubes at 3000 rpm for about 20 seconds in a tabletop centrifuge (with plate holders if using 96-well plates).

9. Amplify the samples in a GeneAmp® PCR System 9700 with the silver or gold-plated silver 96-well block or a Veriti® 96-Well Thermal Cycler.

**Note:** The Yfiler® Kit is not validated for use with the GeneAmp PCR System 9700 with the aluminium 96-well block. Use of this thermal cycling platform may adversely affect performance of the Yfiler® Kit.
Perform PCR

1. Program the thermal cycling conditions:
   - When using the GeneAmp® PCR System 9700 with either 96-well silver or gold-plated silver block, select the **9600 Emulation Mode**.
   - When using the Veriti® 96-Well Thermal Cycler, refer to the following document for instructions on how to configure the Veriti instrument to run in the 9600 Emulation Mode: *User Bulletin: Veriti® 96-Well Thermal Cycler AmpFISTR® Kit Validation* (Part no.4440754).

<table>
<thead>
<tr>
<th>Initial incubation step</th>
<th>Denature</th>
<th>Anneal</th>
<th>Extend</th>
<th>Final extension</th>
<th>Final hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLD</td>
<td>CYCLE (30)</td>
<td>HOLD</td>
<td>HOLD</td>
<td>95°C 11 min</td>
<td>94°C 1 min</td>
</tr>
<tr>
<td>95°C 11 min</td>
<td>94°C 1 min</td>
<td>61°C 1 min</td>
<td>72°C 1 min</td>
<td>60°C 80 min</td>
<td>4°C ∞</td>
</tr>
</tbody>
</table>

2. Load the plate into the thermal cycler and close the heated cover.

**IMPORTANT!** If using the 9700 thermal cycler with silver or gold-plated silver block and adhesive clear film instead of caps to seal the plate wells, be sure to place a MicroAmp® compression pad (Part no. 4312639) on top of the plate to prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not require a compression pad.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.

<table>
<thead>
<tr>
<th>If you are storing the DNA...</th>
<th>Then place at...</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 2 weeks</td>
<td>2 to 8°C</td>
</tr>
<tr>
<td>&gt; 2 weeks</td>
<td>-15 to -25°C</td>
</tr>
</tbody>
</table>

**IMPORTANT!** Store the amplified products so that they are protected from light.
Perform Electrophoresis

- Allelic ladder requirements ............................................................... 23
- Section 3.1 3100/3100-Avant and 3130/3130xl instruments .................... 25
  Set up the 3100/3100-Avant or 3130/3130xl instrument for electrophoresis .... 25
  Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xl instrument ................................................................. 26
- Section 3.2 3500/3500xL Series instruments ........................................... 27
  Set up the 3500/3500xL instrument for electrophoresis ............................ 27
  Prepare samples for electrophoresis on the 3500/3500xL instrument ............ 27
- Section 3.3 310 Instrument ................................................................. 29
  Set up the 310 instrument for electrophoresis ....................................... 29
  Prepare samples for electrophoresis on the 310 instrument ...................... 29

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the unknown samples.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Number of allelic ladders to run</th>
<th>One injection equals</th>
<th>Number of samples per allelic ladder(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3100-Avant or 3130</td>
<td>1 per 4 injections</td>
<td>4 samples</td>
<td>15 samples + 1 allelic ladder</td>
</tr>
<tr>
<td>3100 or 3130xl</td>
<td>1 per injection</td>
<td>16 samples</td>
<td>15 samples + 1 allelic ladder</td>
</tr>
<tr>
<td>3500</td>
<td>1 per 3 injections</td>
<td>8 samples</td>
<td>23 samples + 1 allelic ladder</td>
</tr>
<tr>
<td>3500xL</td>
<td>1 per injection</td>
<td>24 samples</td>
<td>23 samples + 1 allelic ladder</td>
</tr>
<tr>
<td>310</td>
<td>1 per 10 injections</td>
<td>1 sample</td>
<td>9 samples + 1 allelic ladder</td>
</tr>
</tbody>
</table>

**IMPORTANT!** Variation in laboratory temperature can cause changes in fragment migration speed and sizing variation between both single- and multiple-capillary runs (with larger size variations seen between samples injected in multiple-capillary runs). We recommend the above frequency of allelic ladder injections, which should account for normal variation in run speed. However, during internal validation studies, verify the required allelic ladder injection frequency to ensure accurate genotyping of all samples in your laboratory environment.
It is critical to genotype using an allelic ladder run under the same conditions as the samples because size values obtained for the same sample can differ between instrument platforms because of different polymer matrices and electrophoretic conditions.
Section 3.1 3100/3100-Avant and 3130/3130xl instruments

Set up the 3100/3100-Avant or 3130/3130xl instrument for electrophoresis

Reagents and parts

“Ordering Information” on page 105 lists the required materials not supplied with the AmpFSTR® Yfiler® PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect the primer set, amplified DNA, allelic ladder, and size standard from light when not in use. Keep freeze-thaw cycles to a minimum.

Electrophoresis software setup and reference documents

The following table lists Data Collection Software and the run modules that can be used to analyze Yfiler® Kit PCR products. For details on the procedures, refer to the documents listed in the table.

<table>
<thead>
<tr>
<th>Genetic Analyzer</th>
<th>Data Collection Software</th>
<th>Operating System</th>
<th>Run modules and conditions</th>
<th>References</th>
</tr>
</thead>
</table>
| Applied Biosystems® 3130/3130xl | 3.0 | Windows® XP | • HIDFragmentAnalysis36_POP4_1 Injection conditions:  
  - 3130 = 3 kV/5 sec  
  - 3130xl = 3 kV/10 sec  
  • Dye Set G5 | Applied Biosystems 3130/3130xl Genetic Analyzers Using Data Collection Software v3.0, Protocols for Processing AmpFSTR® PCR Amplification Kit PCR Products User Bulletin (Pub no. 4363787) |
| 3100† | 2.0 | Windows® 2000 | • HIDFragmentAnalysis36_POP4_1 Injection condition: 3kV/10 sec  
  • Dye Set G5 | 3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0, Protocols for Processing AmpFSTR® PCR Amplification Kit PCR Products User Bulletin (Pub no. 4350218) |
| | 1.1 | Windows® NT | • GeneScan36vb_DyeSetG5Module Injection condition: 3kV/10 sec  
  • GS600v2.0Analysis.gsp | 3100/3100-Avant Genetic Analyzers Protocols for Processing AmpFSTR® PCR Amplification Kit PCR Products User Bulletin (Pub no. 4332345) |
| 3100-Avant | 1.0 | Windows® NT | • GeneScan36Avb_DyeSetG5Module Injection condition: 3 kV/5sec  
  • GS600v2.0Analysis.gsp | 3100/3100-Avant Genetic Analyzers Protocols for Processing AmpFSTR® PCR Amplification Kit PCR Products User Bulletin (Pub no. 4332345) |

† We conducted validation studies using these configurations.
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xl instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and size standard needed to prepare the samples:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Volume per reaction</th>
<th>OR</th>
<th>Reagent</th>
<th>Volume per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeneScan™ 500 LIZ® Size Standard</td>
<td>0.3 µL</td>
<td></td>
<td>GeneScan™ 600 LIZ® Size Standard v2.0</td>
<td>0.5 µL</td>
</tr>
<tr>
<td>Hi-Di™ Formamide</td>
<td>8.7 µL</td>
<td></td>
<td>Hi-Di™ Formamide</td>
<td>8.5 µL</td>
</tr>
</tbody>
</table>

**Note:** Include additional samples in your calculations to provide excess volume for the loss that occurs during reagent transfers.

**IMPORTANT!** The volume of size standard indicated in the table is a suggested amount. Determine the appropriate amount of size standard based on your experiments and results.

2. Pipette the required volumes of components into an appropriately sized polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:
   - 9 µL of the formamide:size standard mixture
   - 1 µL of PCR product or allelic ladder
   **Note:** For blank wells, add 10 µL of Hi-Di™ Formamide.

5. Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure that the contents of each well are collected at the bottom.

6. Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.

7. Immediately place the plate on ice for 3 minutes.

8. Prepare the plate assembly, then place on the autosampler.

9. Ensure that a plate record is completed and link the plate record to the plate.

10. Start the electrophoresis run.
Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts

“Ordering Information” on page 105 lists the required materials not supplied with the AmpFISTR® Yfiler® PCR Amplification Kit.

**IMPORTANT!** The fluorescent dyes attached to the primers are light sensitive. Protect the primer set, amplified DNA, allelic ladder, and size standard from light when not in use. Keep freeze-thaw cycles to a minimum.

Electrophoresis software setup and reference documents

The following table lists Data Collection Software and the run modules that can be used to analyze Yfiler® Kit PCR products. For details on the procedures, refer to the documents listed in the table.

<table>
<thead>
<tr>
<th>Genetic Analyzer</th>
<th>Data Collection Software</th>
<th>Operating System</th>
<th>Run modules and conditions</th>
<th>References</th>
</tr>
</thead>
</table>
| Applied Biosystems® 3500  | 3500 Data Collection Software v1.0 | Windows® XP or Windows Vista ® | • HID36_POP4 Injection conditions: 1.2kV/15 sec  
• Dye Set G5 | Applied Biosystems® 3500/3500xL Genetic Analyzer User Guide (Pub no. 4401661) |
| Applied Biosystems® 3500xL|                          |                   | • HID36_POP4 Injection conditions: 1.2kV/24 sec  
• Dye Set G5 | Applied Biosystems® 3500 and 3500xL Genetic Analyzers Quick Reference Card (Pub no. 4401662) |

Prepare samples for electrophoresis on the 3500/3500xL instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and GeneScan™ 600 LIZ® Size Standard v2.0 needed to prepare the samples:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Volume per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeneScan™ 600 LIZ® Size Standard v2.0</td>
<td>0.5 µL</td>
</tr>
<tr>
<td>Hi-Di™ Formamide</td>
<td>8.5 µL</td>
</tr>
</tbody>
</table>

**Note:** Include additional samples in your calculations to provide excess volume for the loss that occurs during reagent transfers.

**IMPORTANT!** The volume of size standard indicated in the table is a suggested amount. Determine the appropriate amount of size standard based on your results and experiments.
2. Pipette the required volumes of components into an appropriately sized polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each MicroAmp® optical strip tube, add:
   - 9 µL of the formamide: size standard mixture
   - 1 µL of PCR product or allelic ladder

   **Note:** For blank wells, add 10 µL of Hi-Di™ Formamide.

5. Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to ensure that the contents of each well are collected at the bottom.

6. Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.

7. Immediately put the plate or strip tubes on ice for 3 minutes.

8. Prepare the plate assembly, then place on the autosampler.

9. Ensure that a plate record is completed and link the plate record to the plate.

10. Start the electrophoresis run.
Section 3.3 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and parts

“Ordering Information” on page 105 lists the required materials not supplied with the AmpFSTR® Yfiler® PCR Amplification Kit.

**IMPORTANT!** The fluorescent dyes attached to the primers are light sensitive. Protect the primer set, amplified DNA, allelic ladder, and size standard from light when not in use. Keep freeze-thaw cycles to a minimum.

Electrophoresis software setup and reference documents

The following table lists Data Collection Software and the run modules that can be used to analyze Yfiler® Kit PCR products. For details on the procedures, refer to the documents listed in the table.

<table>
<thead>
<tr>
<th>Data Collection Software</th>
<th>Operating System</th>
<th>Run modules and conditions</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 or 3.0</td>
<td>Windows® XP or Windows® NT and Windows® 2000</td>
<td>• GS STR POP4 (1mL) G5 v2.md5 Injection condition: 15 kV/5 sec</td>
<td>310 Genetic Analyzer User’s Manual (Windows) (Pub no. 4317588) 310 Protocols for Processing AmpFSTR® PCR Amplification Kit Products with Microsoft Windows NT Operating System: User Bulletin (Pub no. 4341742)</td>
</tr>
</tbody>
</table>

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and size standard needed to prepare the samples:

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Volume per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeneScan™ 500 LIZ® Size Standard or GeneScan™ 600 LIZ® Size Standard v2.0</td>
<td>0.75 µL</td>
</tr>
<tr>
<td>Hi-Di™ Formamide</td>
<td>24.5 µL</td>
</tr>
</tbody>
</table>

**Note:** Include additional samples in your calculations to provide excess volume for the loss that occurs during reagent transfers.

**IMPORTANT!** The volume of size standard indicated in the table is a suggested amount. Determine the appropriate amount of size standard based on your results and experiments.
2. Pipette the required volumes of components into an appropriately sized polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each 0.2 mL sample tube, add:
   - 25 µL of the formamide:size standard mixture
   - 1.5 µL of PCR product or allelic ladder
   
   **Note:** For blank wells, add 25 µL of Hi-Di™ Formamide.

5. Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that the contents of each tube are mixed and collected at the bottom.

6. Heat the tubes in a thermal cycler for 3 minutes at 95°C.

7. Immediately place the tubes on ice for 3 minutes.

8. Place the sample tray on the autosampler.

9. Ensure that an injection list is prepared.

10. Start the electrophoresis run.
Section 4.1  GeneMapper® ID Software

Overview of GeneMapper® ID Software

GeneMapper® ID Software is an automated genotyping software for forensic casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample in a .fsa file. Using GeneMapper® ID Software v3.2.1 software, you can then analyze and interpret the data from the .fsa files.

Instruments

Refer to “Instrument and software overview” on page 16 for a list of compatible instruments.
Before you start

When using GeneMapper® ID Software v3.2.1 to perform human identification (HID) analysis with AmpFSTR® kits, be aware that:

- HID analysis requires at least one allelic ladder sample per run folder. Your laboratory can use multiple ladder samples in an analysis, provided individual laboratories conduct the appropriate validation studies.
  
  For multiple ladder samples, the GeneMapper® ID Software calculates allelic bin offsets by using an average of all ladders that use the same panel within a run folder.

- Allelic ladder samples in an individual run folder are considered to be from a single run.
  
  When the software imports multiple run folders into a project, only the ladder(s) within their respective run folders are used for calculating allelic bin offsets and subsequent genotyping.

- Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type column in a project. Failure to apply this setting for ladder samples results in failed analysis.

- Injections containing the allelic ladder must be analyzed with the same analysis method and parameter values that are used for samples to ensure proper allele calling.

- Alleles that are not in the AmpFSTR® Allelic Ladders do exist. Off-ladder (OL) alleles may contain full and/or partial repeat units. An off-ladder allele is an allele that occurs outside the ±0.5-nt bin window of any known allelic ladder allele or virtual bin.

  Note: If a sample allele peak is called as an off-ladder allele, the sample result needs to be verified according to the laboratory’s protocol.

Set up GeneMapper® ID Software for data analysis

File names

The file names shown in this section may differ from the file names you see when you download or import files. If you need help determining the correct files to use, contact your local Life Technologies Human Identification representative, or go to www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper® ID Software.

Before using the software for the first time

Before you can analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for the first time, you need to:

- Import panels and bins into the Panel Manager, as explained in “Import panels and bins” on page 33.

- Create an analysis method, as explained in, “Create an analysis method” on page 37.

- Create a size standard, as explained in “Create size standard” on page 42.

- Define custom views of analysis tables.

- Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial (Pub no. 4335523) for more information.
To import the Yfiler® panel and bin set into the GeneMapper® ID Software v3.2.1 database:

1. Start the GeneMapper® ID Software, then log in with the appropriate user name and password.

   IMPORTANT! If you need logon instructions, refer to page 2-7 of the GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide (Pub no. 4338775).

2. Select Tools ▶ Panel Manager.

3. Find, then open the folder containing the panels and bins:
   a. Select Panel Manager in the navigation pane.
   b. Select File ▶ Import Panels to open the Import Panels dialog box.
   c. Navigate to, then open the $x:\Applied\Biosystems\GeneMapper\Panels$ folder, where $x$ is the drive on which the GeneMapper® ID Software is installed.

4. Select AmpFLSTR_Yfiler_Panel_v2.txt, then click Import.

   Note: Importing this file creates a new folder in the navigation pane of the Panel Manager, AmpFLSTR_Yfiler_Panel_v2. This folder contains the panels and associated markers.
5. Import AmpFLSTR_Yfiler_Bins_v2.txt:
   a. Select the AmpFLSTR_Yfiler_Panel_v2 folder in the navigation pane.

   b. Select File > Import Bin Set to open the Import Bin Set dialog box.

   c. Navigate to, then open the x:\Applied Biosystems\GeneMapper\Panels folder.

   d. Select AmpFLSTR_Yfiler_Bins_v2.txt, then click Import.

   Note: Importing this file associates the bin set with the panels in the AmpFLSTR_Yfiler_Panel_v2 folder.
6. View the imported panels in the navigation pane:
   a. Double-click the AmpFLSTR_Yfiler_Panel_v2 folder.
   b. Double-click the Yfiler_v2 folder to display the panel information in the right pane and the markers below it.

7. View the markers and display the Bin view in the navigation pane:
   a. Select the AmpFLSTR_Yfiler_Panel_v2 folder to display its list of kits in the right pane.
   b. Double-click the Yfiler_v2 folder to display its list of markers below it.
c. Select B_DYS389II to display the Bin view for the marker in the right pane.

8. Click Apply, then OK to add the AmpFISTR® panel and bin set to the GeneMapper® ID Software database.

**IMPORTANT!** If you close the Panel Manager without clicking OK, the panels and bins are not imported into the GeneMapper® ID Software database.
The HID Advanced analysis method for the Yfiler® Kit uses the AmpFLSTR_Yfiler_Bins_v2 file described in step 5 on page 34.

Use the following procedure to create a HID analysis method for the Yfiler® Kit.

1. Select Tools > GeneMapper® Manager to open the GeneMapper Manager.

2. Select the Analysis Methods tab, then click New to open the New Analysis Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General Tab selected.

4. The figures below show the settings for each tab of the Analysis Method Editor. Configure settings as shown unless the instructions state otherwise.

   **Note:** The Analysis Method Editor closes when you save your settings. To complete this step quickly, do not save the analysis method until you finish entering settings in all of the tabs.

5. After you enter settings in all tabs, click Save.
General tab settings

In the Name field, either type the name as shown, or enter a name of your choosing. The Description and Instrument fields are optional.
Allele tab settings

- In the Bin Set field, select the **AmpFLSTR_Yfiler_Bins_v2** bin set imported previously and configure the stutter distance parameters as shown.

- GeneMapper® ID Software v3.2.1 allows you to specify four types of marker repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each type of repeat in the appropriate column.

- Specify the stutter ratio:
  - To apply the stutter ratios listed in the Allele tab for single-source data, deselect the “Use marker-specific stutter ratio if available” check box (selected by default). Perform appropriate internal validation studies to determine the appropriate filter setting to use.
  
  **Note:** Applying global stutter ratios may reduce the editing required for single-source sample data.

  - To apply the stutter ratios contained in the **AmpFLSTR_Yfiler_Panel_v2.txt** file, select the “Use marker-specific stutter ratio if available” check box (selected by default). Perform appropriate internal validation studies to determine the appropriate filter setting to use.
Peak Detector tab settings

IMPORTANT! Perform the appropriate internal validation studies to determine the peak amplitude thresholds for interpretation of Yfiler® Kit data.

Fields include:

- **Peak amplitude thresholds** – The software uses these parameters to specify the minimum peak height, in order to limit the number of detected peaks. Although GeneMapper® ID Software displays peaks that fall below the specified amplitude in electropherograms, the software does not label or determine the genotype of these peaks.

- **Size calling method** – The Yfiler® Kit has been validated using the Local Southern sizing method. Select alternative sizing methods only after performing the appropriate internal validation studies.
Peak Quality tab settings

**IMPORTANT!** Perform the appropriate internal validation studies to determine the minimum heterozygous and homozygous minimum peak height thresholds and the minimum peak height ratio threshold for interpretation of Yfiler® Kit data.
Quality Flags tab settings

**IMPORTANT!** The values shown are the software defaults and are the values we used during developmental validation. Perform the appropriate internal validation studies to determine the appropriate values for interpretation of Yfiler® Kit data.

Create size standard

The size standards for the Yfiler® Kit use the following size standard peaks in their definitions:

<table>
<thead>
<tr>
<th>GeneScan™ 500 LIZ® Size Standard peak sizes</th>
<th>GeneScan™ 600 LIZ® Size Standard v2.0 peak sizes</th>
</tr>
</thead>
</table>

**Note:** The 250-nt peak in the GeneScan™ 500 LIZ® Size Standard is not included in the size standard definition. This peak can be used as an indicator of precision within a run.

Use the following procedure to create the appropriate size standard:

1. Select **Tools > GeneMapper Manager** to open the GeneMapper Manager.
2. Select the Size Standards tab, click New, select the Basic or Advanced radio button, then click OK.

3. Enter a name (for example, CE_G5_Yfiler_GS500 as shown below). In the Size Standard Dye field, select Orange. In the Size Standard Table, enter the sizes specified in on page 42. The example below is for the GeneScan™ 500 LIZ® Size Standard.
Analyze and edit sample files with GeneMapper® ID Software

1. In the Project window, select File ▶ Add Samples to Project, then navigate to the disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Type</td>
<td>Select the sample type.</td>
</tr>
<tr>
<td>Analysis Method</td>
<td>Yfiler_AnalysisMethod_v2 (or the name of the analysis method you created)</td>
</tr>
<tr>
<td>Panel</td>
<td>Yfiler_v2</td>
</tr>
<tr>
<td>Size Standard</td>
<td>CE_G5_Yfiler_GS500† (or the name of the size standard you created)</td>
</tr>
</tbody>
</table>

† The Yfiler® Kit was originally validated using the GeneScan™ 500 LIZ® Size Standard. If you use the GeneScan™ 600 LIZ® Size Standard v2.0 as an alternative, perform the appropriate internal validation studies to support the use of this size standard with the Yfiler® Kit.

Note: For more information about how the Size Caller works, refer to the GeneScan® Analysis Software for the Windows NT® Operating System Overview of the Analysis Parameters and Size Caller User Bulletin (Pub no. 4335617).

3. Click ▶ (Analyze), enter a name for the project (in the Save Project dialog box), then click OK to start analysis.

- The status bar displays the progress of analysis:
  - As a completion bar extending to the right with the percentage indicated
  - With text messages on the left
• The table displays the row of the sample currently being analyzed in green (or red if analysis failed for the sample).
• The Genotypes tab becomes available after analysis (see the figure on the next page).

Project window after analysis

For more information about any of these tasks, refer to the GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide (Pub no. 4338775).

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the Project window to examine the data. These procedures start with the Samples tab of the Project window (assuming the analysis is complete).
For more information

For details about GeneMapper® ID Software features, allele filters, peak detection algorithms, and project editing, refer to:

- GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial (Pub no. 4335523)
- GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide (Pub no. 4338775)
- Installation Procedures and New Features for GeneMapper® ID Software Software Version v3.2 User Bulletin (Pub no. 4352543)
Section 4.2 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

GeneMapper® ID-X Software is an automated genotyping software for forensic casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample in a .fsa file or a .hid file. Using GeneMapper® ID-X Software, you can then analyze and interpret the data from .fsa files (GeneMapper® ID-X Software v1.0.1 or higher) or .hid files (GeneMapper® ID-X Software v1.2 or higher).

Instruments

Refer to “Instrument and software overview” on page 16 for a list of compatible instruments.

Before you start

When using GeneMapper® ID-X Software v1.0.1 or higher to perform human identification (HID) analysis with AmpFISTR® kits, be aware that:

• HID analysis requires at least one allelic ladder sample per run folder. Your laboratory can use multiple ladder samples in an analysis, provided individual laboratories conduct the appropriate validation studies. For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic bin offsets by using an average of all ladders that use the same panel within a run folder.

• Allelic ladder samples in an individual run folder are considered to be from a single run. When the software imports multiple run folders into a project, only the ladder(s) within their respective run folders are used for calculating allelic bin offsets and subsequent genotyping.

• Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type column in a project. Failure to apply this setting for ladder samples results in failed analysis.

• Injections containing the allelic ladder must be analyzed with the same analysis method and parameter values that are used for samples to ensure proper allele calling.

• Alleles that are not in the AmpFISTR® Allelic Ladders do exist. Off-ladder (OL) alleles may contain full and/or partial repeat units. An off-ladder allele is an allele that occurs outside the ±0.5-nt bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result needs to be verified according to the laboratory’s protocol.
Set up GeneMapper® ID-X Software for data analysis

Panel, bin, and stutter file version

The file names shown in this section may differ from the file names you see when you download or import files. If you need help determining the correct files to use, contact your local Life Technologies Human Identification representative, or go to www.lifetechnologies.com/support › Software, Patches & Updates › GeneMapper® ID-X Software.

The instructions and examples in this section refer to the latest version of panel, bin, and stutter file available at the time of publication.

Before using the software for the first time

Before you use GeneMapper® ID-X Software (v1.0.1 or higher for .fsa files, v1.2 or higher for .hid files) to analyze data for the first time, you must do the following:

1. Check the version of panel, bin, and stutter files installed with the GeneMapper® ID-X Software as explained in “Check panel, bin, and stutter file version” below.

2. Check www.lifetechnologies.com/support › Software, Patches & Updates › GeneMapper® ID-X Software to determine if newer files are available.

3. If updated files are available, download and import the files into the GeneMapper® ID-X Software, as explained in “Import panels, bins, and marker stutter” on page 50.
   
   Note: When downloading new versions of analysis files, refer to the associated Read Me file for details of changes between software file versions. If you have validated previous file versions for data analysis, conduct the appropriate internal verification studies before using new file versions for operational analysis.

4. Create an analysis method, as explained in “Create an analysis method” on page 55.

5. Create a size standard, as explained in “Create size standard” on page 60.

6. Define custom views of analysis tables.
   
   Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574) for more information.

7. Define custom views of plots.
   
   Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574) for more information.

For more information

For quick set up instructions, refer to the GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574).

For details about GeneMapper® ID-X Software features, refer to:

- GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574)
- GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub no. 4375670)
- GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub no. 4375671)
Check panel, bin, and stutter file version

1. Start the GeneMapper® ID-X Software, then log in with the appropriate user name and password.

**IMPORTANT!** For logon instructions, refer to the GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574).

2. Select Tools ▶ Panel Manager.

3. Check the version of files imported into the Panel Manager:
   
   a. Select Panel Manager in the navigation pane.
   
   b. Expand the Panel Manager folder and any subfolders to identify the analysis file version already installed for your kit choice.

4. Check the version of files available for import into the Panel Manager:
   
   a. Select Panel Manager, then select File ▶ Import Panels to open the Import Panels dialog box.
   
   b. Navigate to, then open the Panels folder and check the version of panel, bin, and stutter files installed.

5. If newer versions are available on the website, download and import as described below.

Import panels, bins, and marker stutter

To import the Yfiler® Kit panel, bin set, and marker stutter from our web site into the GeneMapper® ID-X Software database:

1. Download and open the file containing panels, bins, and marker stutter:
   
   a. Go to www.lifetechnologies.com/support ▶ Software, Patches & Updates ▶ GeneMapper® ID-X Software. Download the file AmpFLSTR Analysis Files GMIDX.
   
   b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user name and password.

**IMPORTANT!** For logon instructions, refer to the GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574).


4. Find, then open the folder containing the panels, bins, and marker stutter:
   
   a. Select Panel Manager in the navigation pane.

   b. Select File ▶ Import Panels to open the Import Panels dialog box.

   c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder that you unzipped in step 1 on page 50.
5. Select AmpFLSTR_Panels_v2X (or the version you installed), then click Import.

   **Note:** Importing this file creates a new folder in the navigation pane of the Panel Manager “AmpFLSTR_Panels_v2X”. This folder contains the panels and associated markers.

6. Import AmpFLSTR_Bins_v2X.txt:
   
   a. Select the AmpFLSTR_Panels_v2X folder in the navigation pane.

   ![Image of Import Panels dialog]

   b. Select File ➔ Import Bin Set to open the Import Bin Set dialog box.

   c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
d. Select AmpFLSTR_Bins_v2X.txt, then click **Import**.

**Note:** Importing this file associates the bin set with the panels in the AmpFLSTR_Panels_v2X folder.

7. View the imported panels in the navigation pane:
   a. Double-click the AmpFLSTR_Panels_v2X folder.
   b. Double-click the Yfiler_v1.1X folder to display the panel information in the right pane.
8. Select and expand Yfiler_v1.1X in the navigation pane, then select B_DYS389II to display the Bin view for the marker in the right pane.

9. Import AmpFLSTR_Stutter_v2X:
   a. Select the AmpFLSTR_Panels_v2X folder in the navigation panel.
   b. Select File → Import Marker Stutter to open the Import Marker Stutter dialog box.
   c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
d. Select AmpFLSTR_Stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set in the AmpFLSTR_v2X folder.

10. View the imported marker stutters in the navigation pane:
   a. Double-click the AmpFLSTR_Panels_v2X folder to display its list of kits in the right pane.
   b. Double-click the Yfiler_v1.1X folder to display its list of markers below it.
   c. Double-click Y_DYS392 to display the Stutter Ratio & Distance view for the marker in the right pane.

11. Click Apply, then OK to add the Yfiler® Kit panel, bin set, and marker stutter to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels, bin sets, and marker stutter will not be imported into the GeneMapper® ID-X Software database.
Create an analysis method

Use the following procedure to create an analysis method for the Yfiler® Kit.

**IMPORTANT!** Analysis methods are version-specific, so you must create an analysis method for each version of the software. For example, an analysis method created for GeneMapper® ID-X version 1.2 is not compatible with earlier versions of GeneMapper® ID-X Software or with GeneMapper® ID Software version 3.2.1.

1. Select **Tools → GeneMapper® ID-X Manager** to open the GeneMapper® ID-X Manager.

2. Select the **Analysis Methods** tab, then click **New** to open the Analysis Method Editor with the **General** tab selected.

3. The figures below show the settings for each tab of the Analysis Method Editor. Configure the Analysis Method Editor tab settings as shown in the figures below, unless the instructions state otherwise.

   **Note:** The Analysis Method Editor closes when you save your settings. To complete this step quickly, do not save the analysis method until you finish entering settings in all of the tabs.

4. After you enter settings in all tabs, click **Save**.
### General tab settings

**Analysis Method Description**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Yfiler_AnalysisMethod_v2X</td>
</tr>
<tr>
<td>Security Group</td>
<td>GeneMapper ID-X Security Group</td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Instrument</td>
<td></td>
</tr>
<tr>
<td>Analysis Type</td>
<td>HD</td>
</tr>
</tbody>
</table>

In the Name field, either type the name as shown or enter a name of your choosing. In the Security Group field, select the Security Group appropriate to your software configuration from the dropdown list. The Description and Instrument fields are optional.
Allele tab settings

- In the Bin Set field, select the **AmpFLSTR_Bins_v2X** bin set.
- GeneMapper® ID-X Software v1.0.1 or higher allows you to specify 4 types of marker repeat motifs: tri, tetra, penta and hexa. You can enter parameter values for each type of repeat in the appropriate column.
- Specify the stutter ratio:
  - To apply the stutter ratios listed in the Allele tab for single-source data, deselect the “Use marker-specific stutter ratio if available” check box (selected by default). Perform appropriate internal validation studies to determine the appropriate filter setting to use.
  - To apply the stutter ratios contained in the AmpFLSTR_Panels_v2X file, select the “Use marker-specific stutter ratio if available” check box (selected by default). Perform appropriate internal validation studies to determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for single-source sample data.
**Peak Detector tab settings**

**IMPORTANT!** Perform the appropriate internal validation studies to determine the appropriate peak amplitude thresholds for interpretation of Yfiler® Kit data.

Fields include:

- **Peak amplitude thresholds** – The software uses these parameters to specify the minimum peak height, in order to limit the number of detected peaks. Although GeneMapper® ID-X Software displays peaks that fall below the specified amplitude in electropherograms, the software does not label or determine the genotype of these peaks.

- **Size calling method** – The Yfiler® Kit has been validated using the Local Southern sizing method. Select alternative sizing methods only after performing the appropriate internal validation studies.

- **Normalization** – A Normalization checkbox is available on this tab in GeneMapper® ID-X Software v1.2 for use in conjunction with data run on the Applied Biosystems® 3500 Series Genetic Analyzers. Users of this version of software should perform laboratory evaluations to determine whether to use the Normalization feature for analysis of Yfiler® Kit data.
**Section 4.2 GeneMapper® ID-X Software**

*Set up GeneMapper® ID-X Software for data analysis*

---

**Peak Quality tab settings**

<table>
<thead>
<tr>
<th>General</th>
<th>Allele</th>
<th>Peak Detector</th>
<th>Peak Quality</th>
<th>SQ &amp; GQ Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min/Max Peak Height (LPH)</td>
<td>Homozygous min peak height</td>
<td>Heterozygous min peak height</td>
<td>Max Peak Height (MPH)</td>
<td></td>
</tr>
<tr>
<td>Peak Height Ratio (PHR)</td>
<td>Min peak height ratio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Broad Peak (BP)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Max peak width (basepairs)</td>
<td>1.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allele Number (AN)</td>
<td>Max expected alleles</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allele Ladder Spike</td>
<td>Cut-off Value</td>
<td>0.2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**IMPORTANT!** Perform the appropriate internal validation studies to determine the minimum heterozygous and homozygous minimum peak height thresholds, maximum peak height threshold and the minimum peak height ratio threshold for interpretation of Yfiler® Kit data.
Set up GeneMapper® ID-X Software for data analysis

**SQ & GQ tab settings**

**IMPORTANT!** The values shown are the software defaults and are the values we used during developmental validation. Perform appropriate internal validation studies to determine the appropriate values to use.

**Create size standard**

The size standards for the Yfiler® Kit use the following size standard peaks in their definitions:

<table>
<thead>
<tr>
<th>GeneScan™ 500 LIZ® Size Standard peak sizes</th>
<th>GeneScan™ 600 LIZ® Size Standard v2.0 peak sizes</th>
</tr>
</thead>
</table>

**Note:** The 250-nt peak in the GeneScan™ 500 LIZ® Size Standard is not included in the size standard definition. This peak can be used as an indicator of precision within a run.

Use the following procedure to create the appropriate size standard:

1. Select **Tools > GeneMapper Manager** to open the GeneMapper Manager.
2. Select the **Size Standards** tab, click **New**, select the **Basic or Advanced** radio button, then click **OK**.

3. Enter a name (for example, CE_G5_Yfiler_G5500 as shown below). In the Size Standard Dye field, select **Orange**. In the Size Standard Table, enter the sizes specified in **on page 60**. The example below is for the GeneScan™ 500 LIZ® Size Standard.
Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select File › Add Samples to Project, then navigate to the disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Type</td>
<td>Select the sample type.</td>
</tr>
<tr>
<td>Analysis Method</td>
<td>Yfiler_AnalysisMethod_v2X (or the name of the analysis method you created)</td>
</tr>
<tr>
<td>Panel</td>
<td>Yfiler_v1.1X</td>
</tr>
<tr>
<td>Size Standard</td>
<td>CE_G5_Yfiler_GS500 (or the name of the size standard you created)</td>
</tr>
</tbody>
</table>

For more information about how the Size Caller works, or about size standards, refer to the GeneMapper® ID-X Software v1.2 Reference Guide (Pub no. 4426481A).
3. Click (Analyze), enter a name for the project (in the Save Project dialog box), then click OK to start analysis.

- The status bar displays the progress of analysis as a completion bar extending to the right with the percentage indicated.
- The table displays the row of the sample currently being analyzed in green (or red if analysis failed for the sample).
- The Analysis Summary tab is displayed and the Genotypes tab becomes available upon completion of the analysis.

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the Project window to examine the data. These procedures start with the Analysis Summary tab of the Project window (assuming the analysis is complete).
For more information

For more information, refer to:

- GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub no. 4375574)
- GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub no. 4375670)
- GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub no. 4375671)
- GeneMapper® ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide (Pub no. 4396773)
- GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub no. 4426481)
- GeneMapper® ID-X Software Version 1.2 Quick Reference Guide (Pub no. 4426482)
5 Experiments and Results

- Section 5.1 Developmental Validation ......................................................... 66
  Overview ......................................................................................................... 66
  Developmental validation ............................................................................... 67
  Accuracy, precision, and reproducibility ....................................................... 69
  Extra Peaks in the electropherogram ............................................................ 76
  Characterization of loci ............................................................................... 80
  Species specificity ......................................................................................... 81
  Sensitivity ....................................................................................................... 83
  Stability .......................................................................................................... 84
  Mixture studies ............................................................................................. 86
  Population data .............................................................................................. 88
  Mutation rate ................................................................................................ 90

- Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement ................................................................. 92
  Overview ......................................................................................................... 92
  Experiments .................................................................................................... 92
  Reproducibility study ..................................................................................... 93
  Sensitivity study ............................................................................................ 95
  Inhibition study .............................................................................................. 98
  Conclusions .................................................................................................... 101
Section 5.1 Developmental Validation

Overview

This chapter provides results of the developmental validation experiments we performed using the AmpFISTR® Yfiler® PCR Amplification Kit.

Importance of validation

Validation of a DNA typing procedure for human identification applications is an evaluation of the procedure's efficiency, reliability, and performance characteristics. By challenging the procedure with samples commonly encountered in forensic and parentage laboratories, the validation process uncovers attributes and limitations which are critical for sound data interpretation in casework (Sparkes, Kimpton, Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

Experiment conditions

We performed experiments to evaluate the performance of the Yfiler® Kit according to the DNA Advisory Board (DAB) Quality Assurance Standards, effective October 1, 1998 (DNA Advisory Board, 1998). The DAB standards describe the quality assurance requirements that a laboratory should follow to ensure the quality and integrity of the data and competency of the laboratory.

We performed additional studies according to the revised guidelines from the Scientific Working Group on DNA Analysis Methods (SWGDAM, July 10, 2003). This DNA methodology is not novel (Moretti et al., 2001; Frank et al., 2001; Wallin et al., 2002; and Holt et al., 2001).

Based on these standards, we conducted experiments which comply with Standards 1.0 and 2.0 and its associated subsections. Whereas this DNA methodology is not novel, Standard 8.1.2 and its related subsections have been addressed (Holt et al., 2001 and Wallin et al., 2001). This chapter will discuss many of the experiments we performed and examples of the results we obtained. We used conditions that produced maximum PCR product yield and a window in which reproducible performance characteristics were met. These experiments, while not exhaustive, are appropriate for a manufacturer, in our opinion. Each laboratory using the Yfiler® Kit should perform appropriate validation studies.
Developmental validation

SWGDAM Guideline 1.2.1

“Developmental validation is the demonstration of the accuracy, precision, and reproducibility of a procedure by the manufacturer, technical organization, academic institution, government laboratory, or other party.” (SWGDAM, July 2003).

Critical reagent concentrations and reaction conditions (such as thermal cycling parameters, AmpliTaq Gold® DNA polymerase activation, cycle number) to produce reliable, locus-specific amplification and appropriate sensitivity have been determined.

SWGDAM Guideline 2.1.0.1

“The reaction conditions needed to provide the required degree of specificity and robustness must be determined. These include thermocycling parameters, the concentration of primers, magnesium chloride, DNA polymerase, and other critical reagents.” (SWGDAM, July 2003).

PCR components

The concentration of each component of the Yfiler® Kit was examined. The PCR components are Tris-HCl (pH 8.3), KCl, dNTPs, primers, AmpliTaq Gold® DNA Polymerase, MgCl₂, bovine serum albumin, and sodium azide. The concentration for a particular component was established to be in the window that meets the reproducible performance characteristics of specificity and sensitivity (Figure 4). The performance of the multiplex is most robust within a ± 20% window of magnesium chloride.

**Figure 4** A 1 ng amplification of male genomic DNA varying the MgCl₂ concentration, analyzed on the 3100 Genetic Analyzer

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ 30%</td>
<td>+ 20%</td>
<td>+ 10%</td>
<td>Optimal</td>
<td>-10%</td>
<td>-20%</td>
<td>- 30%</td>
<td>+ 20%</td>
<td>+ 10%</td>
<td>+ 20%</td>
<td>+ 20%</td>
<td>+ 20%</td>
</tr>
</tbody>
</table>

Thermal cycler parameters

Thermal cycling parameters were established for amplification of the Yfiler® Kit in the GeneAmp® PCR Systems 9600 and 9700. Thermal cycling times and temperatures of GeneAmp PCR systems were verified. Annealing and denaturation temperature windows were tested around each stipend to verify that a ±1.0°C window produced a specific PCR product with the desired sensitivity of at least 1 ng of AmpFSTR® Control DNA 007.
The effects of denaturation and annealing temperatures on the amplification of Yfiler® Kit loci were examined using AmpFSTR® Control DNA 007 and two DNA samples.

The denaturation temperatures tested were 92.5, 94, and 95.5°C, all for 1-minute hold times on the GeneAmp PCR System 9700. The annealing temperatures tested were 59, 60, 61, 62, and 63°C (Figure 5), also for 1-minute hold times in the GeneAmp PCR System 9700 with the silver 96-well block. The PCR products were analyzed using the 3100 Genetic Analyzer.

No preferential amplification was observed in the denaturation temperature experiments. Of the tested annealing temperatures, 59, 60, and 61°C produced robust profiles. At 63°C, the yield of the majority of loci was significantly reduced. This should pose no problem with routine thermal cycler calibration and when following the recommended amplification protocol. Preferential amplification was not observed at standard annealing temperature of 61°C.

**Figure 5** An amplification of 1 ng of genomic DNA, amplified while varying the annealing temperature, analyzed on the 3100 Genetic Analyzer

The Yfiler® Kit reactions were amplified for 28, 29, 30, 31, and 32 cycles on the GeneAmp® PCR System 9700 using 1.0 ng of three DNA samples. As expected, PCR product increased with the number of cycles (Figure 6). A full profile was generated at 28 cycles; off-scale data were collected for several allele peaks at 32 cycles.

While none of the cycle numbers tested produced nonspecific peaks, 30 cycles was found to give optimal sensitivity when the amplified products were examined on 3100 Genetic Analyzers. At 30 cycles, high ratios of female to male DNA amplify reliably and specifically following the conditions outlined in this user manual (Figure 18 on page 87).
Accuracy, precision, and reproducibility

SWGDAM Guideline 2.9

“The extent to which a given set of measurements of the same sample agree with their mean and the extent to which these measurements match the actual values being measured should be determined.” (SWGDAM, July 2003).

Laser-induced fluorescence detection systems of length polymorphism at short tandem repeat loci is not a novel methodology (Holt et al., 2001 and Wallin et al., 2001). However, accuracy and reproducibility of Yfiler® Kit profiles have been determined from various sample types.

Figure 7 illustrates the size differences that are typically observed between sample alleles and allelic ladder alleles on the 3100 Genetic Analyzer with POP-4® polymer. The x-axis in Figure 7 represents the nominal base pair sizes for the AmpFISTR® Yfiler® Allelic Ladder, and the dashed lines parallel to the x-axis represent the ±0.5-bp windows. The y-axis is the deviation of each sample allele size from the corresponding allelic ladder allele size. All sample alleles are within 0.5 bp of a corresponding allele in an allelic ladder.
Figure 7  Size deviation of 78 samples analyzed on the 3100 Genetic Analyzer

Precision and size windows

Sizing precision allows for determination of accurate and reliable genotypes. Sizing precision was measured on the 3100 Genetic Analyzer. The recommended method for genotyping is to use a ±0.5-bp “window” around the size obtained for each allele in the AmpFSTR® Yfiler® Allelic Ladder. A ±0.5-bp window allows for the detection and correct assignment of alleles. Any sample allele that sizes outside a window could be either of the following:

- An “off-ladder” allele, for example, an allele of a size that is not represented in the AmpFSTR® Yfiler® Allelic Ladder
- An allele that does correspond to an allelic ladder allele, but whose size is just outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of precision in sizing an allele multiple times. Precision is measured by calculating the standard deviation in the size values obtained for an allele that is run in several injections in one capillary run. Table 3 on page 71 indicates typical precision results obtained from the seven injections of the AmpFSTR® Yfiler® Allelic Ladder analyzed on the 3100 Genetic Analyzer (47-cm capillary and POP-4® polymer). The size standard used was GeneScan™ 500 LIZ® Size Standard. These results were obtained within a set of injections on a single capillary.

As indicated above, sample alleles may occasionally size outside of the ±0.5-bp window for a respective allelic ladder allele because of measurement error. The frequency of such an occurrence is lowest in detection systems having the smallest standard deviations in sizing. Figure 7 illustrates the tight clustering of allele sizes obtained on the 3100 Genetic Analyzer, where the standard deviation in sizing is typically less than 0.15 bp. The instance of a sample allele sizing outside of the ±0.5-bp window because of measurement error is relatively rare when the standard deviation in sizing is approximately 0.15 bp or less (Smith, 1995).
For sample alleles that do not size within a ±0.5-bp window, the PCR product must be rerun to distinguish between a true off-ladder allele vs. measurement error of a sample allele that corresponds with an allele in the allelic ladder. Repeat analysis, when necessary, provides an added level of confidence to the final allele assignment. GeneMapper® ID Software and GeneMapper® ID-X Software automatically flags sample alleles that do not size within the prescribed window around an allelic ladder allele.

It is important to note that while the precision within a set of capillary injections is very good, the determined allele sizes vary between platforms. Cross-platform sizing differences arise from a number of parameters, including type and concentration of polymer mixture, run temperature, and electrophoresis conditions. Variations in sizing can also be found between runs on the same instrument and between runs on different instruments because of these parameters. We strongly recommend that the allele sizes obtained be compared to the sizes obtained for known alleles in the AmpFISTR® Yfiler® Allelic Ladder from the same run and then converted to genotypes. For more information on precision and genotyping, see Lazaruk et al., 1998 and Mansfield et al., 1998.

Table 3 Example of precision results of nine injections of the AmpFISTR® Yfiler® Allelic Ladder run on the 3100 Genetic Analyzer

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS456</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>104.51</td>
<td>0.05</td>
</tr>
<tr>
<td>14</td>
<td>108.31</td>
<td>0.05</td>
</tr>
<tr>
<td>15</td>
<td>112.16</td>
<td>0.04</td>
</tr>
<tr>
<td>16</td>
<td>116.04</td>
<td>0.04</td>
</tr>
<tr>
<td>17</td>
<td>119.90</td>
<td>0.05</td>
</tr>
<tr>
<td>18</td>
<td>123.82</td>
<td>0.05</td>
</tr>
<tr>
<td>DYS389I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>142.87</td>
<td>0.04</td>
</tr>
<tr>
<td>11</td>
<td>147.28</td>
<td>0.04</td>
</tr>
<tr>
<td>12</td>
<td>151.80</td>
<td>0.06</td>
</tr>
<tr>
<td>13</td>
<td>156.43</td>
<td>0.07</td>
</tr>
<tr>
<td>14</td>
<td>160.66</td>
<td>0.05</td>
</tr>
<tr>
<td>15</td>
<td>164.81</td>
<td>0.07</td>
</tr>
<tr>
<td>DYS390</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>192.26</td>
<td>0.05</td>
</tr>
<tr>
<td>19</td>
<td>195.99</td>
<td>0.04</td>
</tr>
<tr>
<td>20</td>
<td>199.93</td>
<td>0.05</td>
</tr>
<tr>
<td>21</td>
<td>203.85</td>
<td>0.06</td>
</tr>
<tr>
<td>22</td>
<td>207.83</td>
<td>0.05</td>
</tr>
<tr>
<td>23</td>
<td>211.90</td>
<td>0.04</td>
</tr>
<tr>
<td>24</td>
<td>215.90</td>
<td>0.05</td>
</tr>
<tr>
<td>25</td>
<td>219.88</td>
<td>0.06</td>
</tr>
<tr>
<td>Allele</td>
<td>Mean</td>
<td>Standard Deviation</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>--------------------</td>
</tr>
<tr>
<td>26</td>
<td>223.84</td>
<td>0.06</td>
</tr>
<tr>
<td>27</td>
<td>227.80</td>
<td>0.07</td>
</tr>
<tr>
<td><strong>DYS389I</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>253.05</td>
<td>0.05</td>
</tr>
<tr>
<td>25</td>
<td>257.17</td>
<td>0.06</td>
</tr>
<tr>
<td>26</td>
<td>261.19</td>
<td>0.07</td>
</tr>
<tr>
<td>27</td>
<td>265.38</td>
<td>0.08</td>
</tr>
<tr>
<td>28</td>
<td>269.42</td>
<td>0.08</td>
</tr>
<tr>
<td>29</td>
<td>273.36</td>
<td>0.06</td>
</tr>
<tr>
<td>30</td>
<td>277.63</td>
<td>0.07</td>
</tr>
<tr>
<td>31</td>
<td>281.76</td>
<td>0.09</td>
</tr>
<tr>
<td>32</td>
<td>285.78</td>
<td>0.07</td>
</tr>
<tr>
<td>33</td>
<td>289.93</td>
<td>0.05</td>
</tr>
<tr>
<td>34</td>
<td>293.94</td>
<td>0.06</td>
</tr>
<tr>
<td><strong>DYS458</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>130.98</td>
<td>0.05</td>
</tr>
<tr>
<td>15</td>
<td>134.87</td>
<td>0.06</td>
</tr>
<tr>
<td>16</td>
<td>138.81</td>
<td>0.03</td>
</tr>
<tr>
<td>17</td>
<td>142.95</td>
<td>0.05</td>
</tr>
<tr>
<td>18</td>
<td>147.31</td>
<td>0.05</td>
</tr>
<tr>
<td>19</td>
<td>151.72</td>
<td>0.05</td>
</tr>
<tr>
<td>20</td>
<td>155.94</td>
<td>0.04</td>
</tr>
<tr>
<td><strong>DYS19</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>176.06</td>
<td>0.07</td>
</tr>
<tr>
<td>11</td>
<td>179.98</td>
<td>0.05</td>
</tr>
<tr>
<td>12</td>
<td>183.84</td>
<td>0.05</td>
</tr>
<tr>
<td>13</td>
<td>187.76</td>
<td>0.03</td>
</tr>
<tr>
<td>14</td>
<td>191.64</td>
<td>0.05</td>
</tr>
<tr>
<td>15</td>
<td>195.49</td>
<td>0.05</td>
</tr>
<tr>
<td>16</td>
<td>199.32</td>
<td>0.05</td>
</tr>
<tr>
<td>17</td>
<td>203.20</td>
<td>0.06</td>
</tr>
<tr>
<td>18</td>
<td>207.09</td>
<td>0.07</td>
</tr>
<tr>
<td>19</td>
<td>211.02</td>
<td>0.06</td>
</tr>
<tr>
<td><strong>DYS385 a/b</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>242.79</td>
<td>0.05</td>
</tr>
<tr>
<td>8</td>
<td>246.89</td>
<td>0.07</td>
</tr>
<tr>
<td>9</td>
<td>250.94</td>
<td>0.04</td>
</tr>
<tr>
<td>10</td>
<td>254.98</td>
<td>0.07</td>
</tr>
</tbody>
</table>
## Section 5.1 Developmental Validation

### Accuracy, precision, and reproducibility

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>259.04</td>
<td>0.08</td>
</tr>
<tr>
<td>12</td>
<td>263.08</td>
<td>0.06</td>
</tr>
<tr>
<td>13</td>
<td>267.24</td>
<td>0.05</td>
</tr>
<tr>
<td>14</td>
<td>271.38</td>
<td>0.06</td>
</tr>
<tr>
<td>15</td>
<td>275.47</td>
<td>0.10</td>
</tr>
<tr>
<td>16</td>
<td>279.56</td>
<td>0.08</td>
</tr>
<tr>
<td>17</td>
<td>283.70</td>
<td>0.07</td>
</tr>
<tr>
<td>18</td>
<td>287.79</td>
<td>0.05</td>
</tr>
<tr>
<td>19</td>
<td>292.06</td>
<td>0.06</td>
</tr>
<tr>
<td>20</td>
<td>296.19</td>
<td>0.07</td>
</tr>
<tr>
<td>21</td>
<td>300.42</td>
<td>0.06</td>
</tr>
<tr>
<td>22</td>
<td>305.06</td>
<td>0.12</td>
</tr>
<tr>
<td>23</td>
<td>309.50</td>
<td>0.07</td>
</tr>
<tr>
<td>24</td>
<td>313.99</td>
<td>0.10</td>
</tr>
<tr>
<td>25</td>
<td>318.39</td>
<td>0.05</td>
</tr>
</tbody>
</table>

**DYS393**

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>100.26</td>
<td>0.05</td>
</tr>
<tr>
<td>9</td>
<td>104.19</td>
<td>0.04</td>
</tr>
<tr>
<td>10</td>
<td>108.05</td>
<td>0.04</td>
</tr>
<tr>
<td>11</td>
<td>112.04</td>
<td>0.04</td>
</tr>
<tr>
<td>12</td>
<td>115.98</td>
<td>0.04</td>
</tr>
<tr>
<td>13</td>
<td>119.89</td>
<td>0.04</td>
</tr>
<tr>
<td>14</td>
<td>123.89</td>
<td>0.04</td>
</tr>
<tr>
<td>15</td>
<td>127.80</td>
<td>0.05</td>
</tr>
<tr>
<td>16</td>
<td>131.95</td>
<td>0.04</td>
</tr>
</tbody>
</table>

**DYS391**

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>150.88</td>
<td>0.08</td>
</tr>
<tr>
<td>8</td>
<td>155.27</td>
<td>0.06</td>
</tr>
<tr>
<td>9</td>
<td>159.67</td>
<td>0.06</td>
</tr>
<tr>
<td>10</td>
<td>163.83</td>
<td>0.05</td>
</tr>
<tr>
<td>11</td>
<td>167.94</td>
<td>0.07</td>
</tr>
<tr>
<td>12</td>
<td>172.00</td>
<td>0.07</td>
</tr>
<tr>
<td>13</td>
<td>176.03</td>
<td>0.06</td>
</tr>
</tbody>
</table>

**DYS439**

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>197.84</td>
<td>0.05</td>
</tr>
<tr>
<td>9</td>
<td>201.70</td>
<td>0.03</td>
</tr>
<tr>
<td>10</td>
<td>205.68</td>
<td>0.05</td>
</tr>
<tr>
<td>11</td>
<td>209.46</td>
<td>0.04</td>
</tr>
</tbody>
</table>
### Chapter 5  Experiments and Results

#### Accuracy, precision, and reproducibility

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>213.47</td>
<td>0.03</td>
</tr>
<tr>
<td>13</td>
<td>217.41</td>
<td>0.03</td>
</tr>
<tr>
<td>14</td>
<td>221.42</td>
<td>0.05</td>
</tr>
<tr>
<td>15</td>
<td>225.17</td>
<td>0.04</td>
</tr>
</tbody>
</table>

**DYS635 (Y GATA C4)**

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>246.43</td>
<td>0.07</td>
</tr>
<tr>
<td>21</td>
<td>250.49</td>
<td>0.06</td>
</tr>
<tr>
<td>22</td>
<td>254.45</td>
<td>0.06</td>
</tr>
<tr>
<td>23</td>
<td>258.49</td>
<td>0.03</td>
</tr>
<tr>
<td>24</td>
<td>262.45</td>
<td>0.06</td>
</tr>
<tr>
<td>25</td>
<td>266.56</td>
<td>0.06</td>
</tr>
<tr>
<td>26</td>
<td>270.56</td>
<td>0.03</td>
</tr>
</tbody>
</table>

**DYS392**

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>291.38</td>
<td>0.05</td>
</tr>
<tr>
<td>8</td>
<td>294.39</td>
<td>0.07</td>
</tr>
<tr>
<td>9</td>
<td>297.44</td>
<td>0.06</td>
</tr>
<tr>
<td>10</td>
<td>300.30</td>
<td>0.06</td>
</tr>
<tr>
<td>11</td>
<td>303.91</td>
<td>0.07</td>
</tr>
<tr>
<td>12</td>
<td>307.44</td>
<td>0.07</td>
</tr>
<tr>
<td>13</td>
<td>310.64</td>
<td>0.08</td>
</tr>
<tr>
<td>14</td>
<td>313.74</td>
<td>0.07</td>
</tr>
<tr>
<td>15</td>
<td>317.12</td>
<td>0.11</td>
</tr>
<tr>
<td>16</td>
<td>320.45</td>
<td>0.08</td>
</tr>
<tr>
<td>17</td>
<td>323.54</td>
<td>0.09</td>
</tr>
<tr>
<td>18</td>
<td>326.79</td>
<td>0.10</td>
</tr>
</tbody>
</table>

**Y GATA H4**

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>122.01</td>
<td>0.06</td>
</tr>
<tr>
<td>9</td>
<td>125.98</td>
<td>0.06</td>
</tr>
<tr>
<td>10</td>
<td>129.97</td>
<td>0.07</td>
</tr>
<tr>
<td>11</td>
<td>134.01</td>
<td>0.04</td>
</tr>
<tr>
<td>12</td>
<td>138.09</td>
<td>0.03</td>
</tr>
<tr>
<td>13</td>
<td>142.37</td>
<td>0.05</td>
</tr>
</tbody>
</table>

**DYS437**

<table>
<thead>
<tr>
<th>Allele</th>
<th>Mean</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>182.53</td>
<td>0.05</td>
</tr>
<tr>
<td>14</td>
<td>186.45</td>
<td>0.07</td>
</tr>
<tr>
<td>15</td>
<td>190.40</td>
<td>0.04</td>
</tr>
<tr>
<td>16</td>
<td>194.25</td>
<td>0.04</td>
</tr>
<tr>
<td>17</td>
<td>198.07</td>
<td>0.03</td>
</tr>
<tr>
<td>Allele</td>
<td>Mean</td>
<td>Standard Deviation</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
<td>--------------------</td>
</tr>
<tr>
<td>DY438</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>223.69</td>
<td>0.06</td>
</tr>
<tr>
<td>9</td>
<td>228.68</td>
<td>0.06</td>
</tr>
<tr>
<td>10</td>
<td>233.63</td>
<td>0.07</td>
</tr>
<tr>
<td>11</td>
<td>238.59</td>
<td>0.06</td>
</tr>
<tr>
<td>12</td>
<td>243.63</td>
<td>0.05</td>
</tr>
<tr>
<td>13</td>
<td>248.66</td>
<td>0.05</td>
</tr>
<tr>
<td>DYS448</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>280.49</td>
<td>0.04</td>
</tr>
<tr>
<td>18</td>
<td>286.58</td>
<td>0.03</td>
</tr>
<tr>
<td>19</td>
<td>292.70</td>
<td>0.05</td>
</tr>
<tr>
<td>20</td>
<td>298.92</td>
<td>0.05</td>
</tr>
<tr>
<td>21</td>
<td>305.51</td>
<td>0.04</td>
</tr>
<tr>
<td>22</td>
<td>312.25</td>
<td>0.06</td>
</tr>
<tr>
<td>23</td>
<td>318.60</td>
<td>0.10</td>
</tr>
<tr>
<td>24</td>
<td>324.88</td>
<td>0.08</td>
</tr>
</tbody>
</table>
Extra Peaks in the electropherogram

Causes of extra peaks

Peaks other than the target alleles may be detected on the electropherogram displays. Several causes for the appearance of extra peaks, including the stutter product (at the n–4 position), incomplete 3’ A nucleotide addition (at the n–1 position), artifacts, and mixed DNA samples (see “SWGDAM Guideline 2.8” on page 86).

Stutter products

A stutter is a well-characterized PCR artifact that refers to the appearance of a minor peak one repeat unit smaller (or less frequently, one repeat larger) than the major STR product (Butler, 2001). Sequence analysis of stutter products at tetranucleotide STR loci has revealed that the stutter product is missing a single tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996). It has been reported that the DYS19 tetranucleotide repeat locus displays the typical -4 bp stutter but also a -2 bp stutter (Prinz et al., 2001; Gusmao et al., 1999). The DYS392 trinucleotide repeat locus displays the typical -3 bp stutter but also a smaller +3 bp stutter. Sequence analysis of this +3 bp stutter revealed that the product contains an additional repeat unit relative to the true allele peak.

The proportion of the stutter product relative to the main allele (stutter percent) is measured by dividing the height of the stutter peak by the height of the main allele peak. Such measurements have been made for amplified samples at the loci used in the Yfiler® Kit. All data were generated on the 3100 Genetic Analyzer.

Some of the general conclusions from these measurements and observations are as follows:

- For each Yfiler® Kit locus, the stutter percent generally increases with allele length, as shown in Figure 8 through Figure 11 on the following pages. Smaller alleles display a lower level of stutter relative to the longer alleles within each locus. This is reflected in Figure 8 through Figure 11, where minimal data points are plotted for some smaller alleles, as stutter could not be detected for many of these samples.

- Each allele within a locus displays percent stutter that is reproducible.

- The highest observed stutter percent for each locus is included as the filter in the GeneMapper® ID Software and the GeneMapper® ID-X Software. Peaks in the stutter position that are above the highest observed stutter percent will not be filtered. Peaks in the stutter position that have not been filtered and remain labeled can be further evaluated. For evaluation of mixed samples, see “Mixture studies” on page 86.

- The measurement of percent stutter may be unusually high for main peaks that are off-scale.
Section 5.1 Developmental Validation
Extra Peaks in the electropherogram

Figure 8 Stutter percentages for the DYS456, DYS389I, DYS390 and DYS389II loci.

Figure 9 Stutter percentages for the DYS458, DYS19 and DYS385 loci. The -4 bp and -2 bp stutter percentages for DYS19 are shown in blue and green, respectively.
Figure 10  Stutter percentages for the DYS393, DYS391, DYS439, DYS635, DYS392 loci. The DYS392 [-3 bp] and [+3 bp] stutter percentages are shown in blue and grey respectively.

Figure 11  Stutter percentages for the Y GATA H4, DYS437, DYS438 and DYS448 loci

Addition of 3´A

AmpliTaq Gold® enzyme, like many other DNA polymerases, can catalyze the addition of a single nucleotide (predominately adenosine) to the 3´ ends of double-stranded PCR products (Clark, 1988; Magnuson et al.,1996). This non-template addition results in a PCR product that is one base pair longer than the actual target sequence, and the PCR product with the extra nucleotide is referred to as the “+A” form (Figure 12).
Section 5.1 Developmental Validation

Extra Peaks in the electropherogram

The efficiency of “A addition” is related to the particular sequence of the DNA at the 3’ end of the PCR product. The Yfiler® Kit includes two main design features that promote maximum A addition:

- The primer sequences have been optimized to encourage A addition.
- The final extension step is 60°C for 80 minutes.

This final extension step gives the AmpliTaq Gold® DNA Polymerase extra time to complete A addition to all double-stranded PCR product. STR systems that have not been optimized for maximum A addition may have “split peaks”, where each allele is represented by two peaks one base pair apart.

**Figure 12** Split peaks resulting from incomplete A nucleotide addition due to omission of the 80-minute extension step

Lack of full A nucleotide addition may be observed in Yfiler® Kit results when the amount of input DNA is greater than recommended protocols. This is because more time is needed for AmpliTaq Gold® DNA Polymerase to add the A nucleotide to all molecules as more PCR product is generated. Amplification of too much input DNA will also result in off-scale data.

**Artifacts**

Artifacts, or anomalies, have been seen in data produced on genetic analyzers when using the Yfiler® Kit. In amplified samples, artifacts in the non-calling region may appear in the green (88 bp), black (80 and 95 bp), and red (80 bp) dye. Low level artifacts in the calling region may or may not be reproducible.

**Figure 13** demonstrates reproducible artifacts while using the Yfiler® Kit. Consider these artifacts when interpreting data.
Characterization of loci

SWGDAM Guideline 2.1

“The basic characteristics of a genetic marker must be determined and documented.” (SWGDAM, July 2003).

This section describes basic characteristics of the 17 loci that are amplified with the Yfiler® Kit. These loci have been extensively characterized by other laboratories (Gusmao et al., 1999; Butler et al., 2002; Gonzalez-Neira et al., 2001; Hall and Ballantyne, 2003; Redd et al., 2002; Schoske et al., 2004).

Nature of the polymorphisms

DYS392 is a trinucleotide repeat, DYS438 is a pentanucleotide repeat and DYS448 is a hexanucleotide repeat. Their allele differences result from differences in the number of repeat units 3-bp, 5-bp and 6-bp respectively. The remaining Yfiler® Kit loci are tetranucleotide short tandem repeat (STR) loci. The length differences among alleles of these particular loci result from differences in the number of 4-bp repeat units.

We have sequenced all the alleles in the AmpFISTR® Yfiler® Allelic Ladder. In addition, other groups in the scientific community have sequenced alleles at some of these loci (Redd et al., 2002; www.cstl.nist.gov/biotech/strbase/y_strs.htm). Among the various sources of sequence data on the Yfiler® Kit loci, there is consensus on the repeat patterns and structure of the STRs.
Inheritance

The Centre d’Etude du Polymorphisme Humain (CEPH) has collected DNA from 39 families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets have been extensively studied all over the world and are routinely used to characterize the mode of inheritance of various DNA loci. Each family set contains three generations, generally including four grandparents, two parents, and several offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance patterns (Begovich et al., 1992).

Three CEPH family DNA sets were examined. 1 ng of DNA from each sample was amplified using the Yfiler® Kit and the Identifiler® Kit, followed by analysis using a 3100 Genetic analyzer. The families examined included #1333 (9 offspring, 7 males), #1340 (7 offspring, 5 males), and #1345 (7 offspring, 5 males), representing 23 meiotic divisions. The Identifiler® Kit results confirmed that the loci are inherited according to Mendelian rules, as reported in the literature (Nakahori et al., 1991; Edwards et al., 1992; Kimpton et al., 1992; Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993). The Yfiler® Kit results confirmed that the loci were inherited according to a Y-linked (father to son) transmission. In no case was the maternal grandfather’s Y-haplotype found in the offspring. In family #1345, one son (1345-7356) had a DYS458-18 allele while the rest of his male relatives had a DYS458-17 allele. In family #1340 one son (1340-7342) had a DYS458-16 allele while the rest of his male relatives had DYS458-17. Calculation of a mutation rate based on this small population size would be inaccurate due to the small sample size. The samples were reamplified and reinjected to confirm the allele call.

Mapping

The Yfiler® Kit loci have been mapped and the chromosomal location on the Y-chromosome is known based on the nucleotide sequence of the Y-chromosome. The Genbank accession numbers for representative sequences are: DYS19 (X77751, AC017019), DYS385 (AC022486, Z93950), DYS389 (AC011289, AF140635), DYS390 (AC011289), DYS391 (G09613, AC011302), DYS392 (G09867, AC06152), DYS393 (G09601, AC06152), DYS437 (AC002992), DYS438 (AC002531), DYS439 (AC002992), DYS448 (AC025227.6), DYS456 (AC010106.2), DYS458 (AC010902.4), DYS635 (G42676, AC011751) and Y GATA C4 (G42673).

Species specificity

SWGDAM Guideline 2.2

“For techniques designed to type human DNA, the potential to detect DNA from forensically relevant nonhuman species should be evaluated.” (SWGDAM, July 2003).

The Yfiler® Kit provides the required degree of specificity such that it is specific to primates. Other species do not amplify for the loci tested.

Nonhuman Studies

Nonhuman DNA may be present in forensic casework samples. The Yfiler® Kit provides the required degree of specificity for the species tested (Figure 14).
Figure 14  Representative electropherograms from a species specificity study including positive and negative control

The following experiments were conducted to investigate interpretation of Yfiler® Kit results from nonhuman DNA sources.

The extracted DNA samples were amplified in Yfiler® Kit reactions and analyzed using the 3100 Genetic Analyzer.

- **Primates** – Gorilla, chimpanzee, orangutan, and macaque (1.0 ng each).
- **Non-primates** – Mouse, dog, pig, cat, horse, chicken and cow (10 ng each).
- **Microorganisms** – *Candida albicans, Neisseria gonorrhoeae, Escherichia coli O157:H7, Bacillus subtilis, Staphylococcus aureus*, and *Lactobacillus rhamnosus* (5 ng each).

The chimpanzee and gorilla DNA samples produced partial profiles within the 100–330 base pair region.

The remaining species tested did not yield reproducible detectable products.
Sensitivity

SWGDAM Guideline 2.3

Effect of DNA quantity on results and importance of quantitation

“When appropriate, the range of DNA quantities able to produce reliable typing results should be determined.” (SWGDAM, July 2003).

The amount of input DNA added to the Yfiler® Kit should be between 0.5 and 1.0 ng (Figure 15 on page 84). The DNA sample should be quantitated prior to amplification using a system such as the Quantifiler® Human DNA Quantitation Kit (Part no. 4343895) or the Quantifiler® Y Human Male DNA Quantification Kit (Part no. 4343906). The final DNA concentration should be in the range of 0.05–0.10 ng/μL so that 0.05–0.10 ng of DNA will be added to the PCR reaction in a volume of 10 μL. If the sample contains degraded DNA, amplification of additional DNA may be beneficial.

If too much DNA is added to the PCR reaction, then the increased amount of PCR product that is generated can result in the following:

- Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument (”off-scale” data).
  Off-scale data is a problem for two reasons:
  - Quantitation (peak height and area) for off-scale peaks is not accurate. For example, an allele peak that is off-scale can cause the corresponding stutter peak to appear higher in relative intensity, thus increasing the calculated percent stutter.
  - Multicomponent analysis of off-scale data is not accurate, which results in poor spectral separation (“pull-up”).

- Incomplete A nucleotide addition.

The sample can be re-amplified using less DNA.

Individual laboratories may find it useful to determine an appropriate minimum peak height threshold based on their own results and instruments using low amounts of input DNA.
Figure 15 Effect of amplifying 1 ng, 500 pg, 250 pg, 125 pg and 62 pg of male control DNA 007. Data analyzed using the 3100 Genetic Analyzer.

Note: The y-axis scale is magnified for the lower amounts of DNA.

Stability

**SWGDAM Guideline 2.4**

“The ability to obtain results from DNA recovered from biological samples deposited on various substrates and subjected to various environmental and chemical insults has been extensively documented. In most instances, assessment of the effects of these factors on new forensic DNA procedures is not required. However, if substrates and/or environmental and/or chemical insults could potentially affect the analytical process, then the process should be evaluated using known samples to determine the effects of such factors.” (SWGDAM, July 2003).

Lack of amplification of some loci

As with any multi-locus system, the possibility exists that not every locus will amplify. This is most often observed when the DNA sample contains PCR inhibitors or when the DNA sample has been severely degraded. Valuable information may be obtained from partial profiles.

Effect of inhibitors

Heme compounds have been identified as PCR inhibitors in DNA samples extracted from bloodstains (DeFranchis et al., 1988; Akane et al., 1994). It is believed that the inhibitor is co-extracted and co-purified with the DNA and subsequently interferes with PCR by inhibiting polymerase activity.

To examine the effects of hematin on the amplification results obtained by the Yfiler® Kit, DNA samples were amplified using the Yfiler® Kit reagents (including the BSA-containing PCR reaction mix) in the presence of varying concentrations of purified hematin. The concentrations of hematin used were 0 μM, 10 μM, 12 μM, 16 μM, 20 μM, and 24 μM. No preferential amplification was observed in the presence of increasing amounts of hematin.
Figure 16  DNA amplified with the Yfiler® Kit in the presence of varying concentrations of hematin: 0, 10 μM, 12 μM, 16 μM, 18 μM, 20 μM, and 24 μM, analyzed on the 3100 Genetic Analyzer.

Degraded DNA

As the average size of degraded DNA approaches the size of the target sequence, the amount of PCR product generated is reduced. This is due to the reduced number of intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential amplification of loci. High molecular weight DNA was incubated with the enzyme DNase I for varying amounts of time. The DNA was examined by agarose gel analysis to determine the average size of the DNA fragments at each time point.

2 ng of degraded DNA (or 1 ng undegraded DNA) was amplified using the Yfiler® Kit. As the DNA became increasingly degraded, the loci became undetectable according to size. Preferential amplification was not observed. The loci failed to robustly amplify in the order of decreasing size as the extent of degradation progressed (Figure 17).
Figure 17  Multiplex amplification of DNA samples incubated with DNAse I (top panel = 1 ng of DNA with no DNAse I added; remaining panels = 2 ng of DNA incubated with DNAse I)

Mixture studies

SWGDAM Guideline 2.8

“The ability to obtain reliable results from mixed source samples should be determined.” (SWGDAM, July 2003).

Evidence samples may contain DNA from more than one individual. The possibility of multiple contributors should be considered when interpreting the results. We recommend that individual laboratories assign a minimum peak height threshold based on validation experiments performed in each laboratory to avoid typing when stochastic effects are likely to interfere with accurate interpretation of mixtures.

Male/female mixture studies

Evidence samples that contain body fluids and/or tissues originating from more than one individual are an integral component of forensic casework. Therefore it is essential to ensure that the DNA typing system is able to detect DNA mixtures. In the case of Y-STRs, the female DNA component is not amplified by the Y-chromosome specific primers. Male/female mixture studies were performed up to a ratio of 1:2000 using three different female DNAs. The amount of female DNA was kept constant at 500 ng and the amount of male control DNA was changed. The female DNA did not cause any interference with the interpretation of the male Y-STR profile as shown in Figure 18.

Low level artifacts with female DNA have been occasionally observed in the black (136 bp) and red (291 bp) dye. In general, these artifacts peaks will not affect interpretation due to their intensity.
**Male/male mixture studies**

Forensic samples may contain body fluids or tissues originating from more than one male.

Mixtures of two male DNA samples were examined at various ratios (1:1 to 1:10). The total amount of genomic input DNA mixed at each ratio was 1 ng.

The samples were amplified in a GeneAmp® PCR System 9700 with the silver 96-well block and were electrophoresed and detected using an Applied Biosystems® 3100 Genetic Analyzer.

**Table 4** Haplotypes of samples in Figure 19

<table>
<thead>
<tr>
<th>Allele</th>
<th>Sample A</th>
<th>Sample B</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS19</td>
<td>14</td>
<td>15</td>
</tr>
<tr>
<td>DYS385a</td>
<td>11</td>
<td>13</td>
</tr>
<tr>
<td>DYS385b</td>
<td>14</td>
<td>15</td>
</tr>
<tr>
<td>DYS389I</td>
<td>13</td>
<td>12</td>
</tr>
<tr>
<td>DYS389III</td>
<td>31</td>
<td>28</td>
</tr>
<tr>
<td>DYS390</td>
<td>24</td>
<td>23</td>
</tr>
<tr>
<td>DYS391</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>DYS392</td>
<td>13</td>
<td>11</td>
</tr>
<tr>
<td>DYS393</td>
<td>13</td>
<td>14</td>
</tr>
<tr>
<td>DYS437</td>
<td>15</td>
<td>16</td>
</tr>
<tr>
<td>DYS438</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>DYS439</td>
<td>12</td>
<td>13</td>
</tr>
</tbody>
</table>
The results of 1-ng total male/male DNA mixture studies are shown in Figure 19. The limit of detection is when the minor component is present at approximately one-tenth of the concentration of the major component and a threshold of 50 RFU. The limit of detection for the minor component is influenced by the combination of genotypes in the mixture.

**Figure 19** Mixtures of two male DNA samples (A and B and A:B ratios) 1-ng input DNA. The alleles attributable to the minor component, even when the major component shares an allele, are highlighted.

<table>
<thead>
<tr>
<th>Allele</th>
<th>Sample A</th>
<th>Sample B</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS448</td>
<td>19</td>
<td>21</td>
</tr>
<tr>
<td>DYS456</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>DYS458</td>
<td>18</td>
<td>16</td>
</tr>
<tr>
<td>DYS635</td>
<td>23</td>
<td>22</td>
</tr>
<tr>
<td>Y GATA H4</td>
<td>12</td>
<td>12</td>
</tr>
</tbody>
</table>

The results of 1-ng total male/male DNA mixture studies are shown in Figure 19. The limit of detection is when the minor component is present at approximately one-tenth of the concentration of the major component and a threshold of 50 RFU. The limit of detection for the minor component is influenced by the combination of genotypes in the mixture.

**Population data**

**SWGDAM Guideline 2.7**

“The distribution of genetic markers in populations should be determined in relevant population groups.” (SWGDAM, July 2003)

**Overview**

To interpret the significance of a match between genetically typed samples, it is necessary to know the population distribution of alleles at each locus in question. If the genotype of the relevant evidence sample is different from the genotype of the suspect’s reference sample, then the suspect is “excluded” as the donor of the biological evidence tested. An exclusion is independent of the frequency of the two genotypes in the population.
If the suspect and evidence samples have the same genotype, then the suspect is “included” as a possible source of the evidence sample. The probability that another, unrelated, individual would also match the evidence sample is estimated by the frequency of that genotype in the relevant population(s).

The Yfiler® Kit was used to generate the population data provided in this section. Samples were collected from individuals throughout the United States with no geographical preference.

### Gene diversity values

Table 5 shows the Yfiler® Kit gene diversity in three populations, listed as percentages.

<table>
<thead>
<tr>
<th>Locus</th>
<th>African-American (n = 333)</th>
<th>U.S. Caucasian (n = 254)</th>
<th>U.S. Hispanic (n = 175)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYS458</td>
<td>0.755</td>
<td>0.808</td>
<td>0.77</td>
</tr>
<tr>
<td>DYS19</td>
<td>0.748</td>
<td>0.541</td>
<td>0.645</td>
</tr>
<tr>
<td>DYS385a/b</td>
<td>0.951</td>
<td>0.855</td>
<td>0.931</td>
</tr>
<tr>
<td>DYS393</td>
<td>0.619</td>
<td>0.412</td>
<td>0.507</td>
</tr>
<tr>
<td>DYS391</td>
<td>0.423</td>
<td>0.54</td>
<td>0.52</td>
</tr>
<tr>
<td>DYS439</td>
<td>0.629</td>
<td>0.663</td>
<td>0.665</td>
</tr>
<tr>
<td>DYS635</td>
<td>0.701</td>
<td>0.682</td>
<td>0.71</td>
</tr>
<tr>
<td>DYS392</td>
<td>0.419</td>
<td>0.615</td>
<td>0.671</td>
</tr>
<tr>
<td>Y GATA H4</td>
<td>0.599</td>
<td>0.604</td>
<td>0.575</td>
</tr>
<tr>
<td>DYS437</td>
<td>0.495</td>
<td>0.624</td>
<td>0.583</td>
</tr>
<tr>
<td>DYS438</td>
<td>0.528</td>
<td>0.622</td>
<td>0.712</td>
</tr>
<tr>
<td>DYS448</td>
<td>0.685</td>
<td>0.651</td>
<td>0.726</td>
</tr>
</tbody>
</table>

Gene diversity (D) = \( \frac{n(1 - \sum_{i=1}^{n} p_i^2)}{n-1} \) where n = sample size, \( p_i \) = allele frequency (Johnson et al., 2003).

In addition to the alleles that were observed and recorded in the Life Technologies databases, other known alleles have been published or reported to us by other laboratories. Some of these alleles occur at a low frequency and include several microvariants (Furedi et al., 1999; Schoske et al., 2004).
Discriminatory capacity of haplotypes

Table 6 shows the discriminatory capacity (DC) and the number of unique haplotypes (UH) for each Y-STR marker combination listed. The discriminatory capacity was determined by dividing the number of different haplotypes by the number of samples in that population (Schoske et al., 2004). A unique haplotype is defined as one that occurs only once in a given population. The number of unique haplotypes is usually less than the number of different haplotypes in any given population.

Table 6 Discriminatory capacity and number of unique haplotypes for three U.S. populations

<table>
<thead>
<tr>
<th>Y-STR marker combination</th>
<th>African-American (N=333)</th>
<th>U.S. Caucasian (N=254)</th>
<th>U.S. Hispanics (N=175)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DC (%)</td>
<td>UH</td>
<td>DC (%)</td>
</tr>
<tr>
<td>&quot;Minimal haplotype&quot;†</td>
<td>84.6</td>
<td>249</td>
<td>74.8</td>
</tr>
<tr>
<td>&quot;U.S. haplotype&quot;‡</td>
<td>91.3</td>
<td>286</td>
<td>83.8</td>
</tr>
<tr>
<td>&quot;U.S. haplotype + DYS437&quot;</td>
<td>91.9</td>
<td>286</td>
<td>85.8</td>
</tr>
<tr>
<td>&quot;Yfiler haplotype&quot;</td>
<td>99.1</td>
<td>327</td>
<td>98.8</td>
</tr>
</tbody>
</table>

† The "minimal haplotype" includes the markers DYS19, DYS385 a/b, DYS389 I/II, DYS390, DYS391, DYS392, DYS393.
‡ The "U.S. haplotype" includes the minimal haplotype loci plus DYS438 and DYS439.

Mutation rate

Estimation of spontaneous or induced germline mutation at genetic loci may be achieved through comparison of the genotypes of offspring to those of their parents. From such comparisons the number of observed mutations are counted directly.

In previous studies, haplotypes of eight loci amplified by the Yfiler® Kit were determined for a total of 4999 parent-son (Kayser and Sajantila, 2001). Fourteen mutations were identified and an overall average mutation rate was estimated at $2.80 \times 10^{-3}$. In two confirmed father/son pairs mutation at two Y-STRs were observed.

Additional studies need to be performed for other loci in order to estimate their average mutation rate.
Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement

Overview

As part of an ongoing program to exercise greater control over raw materials used in the AmpFISTR® PCR Amplification Kits, manufacturing of the AmpliTaq Gold® enzyme and 10X PCR Buffer II (Tris-KCl buffer) components is transitioning from Roche Molecular Systems to Life Technologies. Manufacturing of both components by Life Technologies will be conducted according to the same specifications used previously by Roche. The in-house components are established raw materials in our next generation kits (for example, the NGM™, NGM SElect™ and Identifiler® Plus Kits).

Experiments

We performed studies to compare the performance of the Yfiler® Kit containing the in-house components (updated kit) with the performance of the original kit, focusing on studies most relevant to forensic DNA testing (see SWGDAM Guidelines effective January 1, 2011). These studies, while not exhaustive, are in our opinion appropriate for a manufacturer. Each laboratory using the Yfiler® Kit should assess their own requirements for evaluation of kits.

Our studies compared the performance of two Roche-manufactured enzyme and buffer lots (Control mixes) with three new lots of buffer and two new lots of enzyme manufactured by Life Technologies (Test mixes). Studies were performed using Test mixes containing both the enzyme and buffer manufactured by Life Technologies.

<table>
<thead>
<tr>
<th>Test Material</th>
<th>Control A mix</th>
<th>Control B mix</th>
<th>Test A mix</th>
<th>Test B mix</th>
<th>Test C mix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffer</td>
<td>Control Buffer Lot 1</td>
<td>Control Buffer Lot 2</td>
<td>Test Buffer Lot 1</td>
<td>Test Buffer Lot 2</td>
<td>Test Buffer Lot 3</td>
</tr>
<tr>
<td>Enzyme</td>
<td>Control Enzyme Lot 1</td>
<td>Control Enzyme Lot 2</td>
<td>Test Enzyme Lot 1</td>
<td>Control Enzyme Lot 2</td>
<td>Test Enzyme Lot 2</td>
</tr>
</tbody>
</table>

Each of the five mixes listed above were used to conduct reproducibility, sensitivity, and inhibition studies. All amplifications were performed using a GeneAmp® PCR System 9700 with either silver or gold-plated silver block using the recommended amplification conditions and cycle number for the Yfiler® Kit. All data was run on an Applied Biosystems® 3130xl Genetic Analyzer running Data Collection Software v3.0 and analyzed using GeneMapper® ID-X Software. Subsequent data analysis was performed using Minitab® Statistical Software. To minimize the effect of injection-to-injection variation on result interpretation, peaks heights for all studies were normalized using an in-house, multicolor reference standard.
Reproducibility study

For the reproducibility study, 12 replicates of control DNA 007 at 1 ng input and three negative control replicates were amplified. The results were evaluated for intracolor balance, stutter percentage, and the presence, signal intensity, and location of artifacts.

Intracolor balance

The Test mixes delivered lower intracolor balance results for the FAM™ dye channel (blue) but improved intracolor balance results for the NED™ dye channel (yellow) compared to the Control mixes. The levels of intracolor balance obtained for the Test and Control mixes all fall within the expected range of performance for the Yfiler® Kit. (Figure 20).

Stutter percentages

Stutter percentage results for each marker were comparable across all Test and Control mixes (Figure 21).
Chapter 5  Performance Validation After Buffer and Enzyme Component Replacement

Reproducibility study

Artifacts

Known artifacts observed showed the same morphology, signal intensity, and location in all Test and Control mixes and did not exceed 50 RFU (Figure 22). No new artifacts were observed in the Test mixes.

Figure 21 Reproducibility study: mean stutter percentage

![Graph showing mean stutter percentage for different loci and dye colors.](image)

Dye Color and Locus

Figure 22 Reproducibility study: known artifacts (Y-scale 50 RFU)

<table>
<thead>
<tr>
<th>Dye Label</th>
<th>Artifacts Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIC®</td>
<td>~75 and 115 bp</td>
</tr>
<tr>
<td>NED™</td>
<td>~88 bp</td>
</tr>
<tr>
<td>FAM™</td>
<td>~110 bp</td>
</tr>
<tr>
<td>PET®</td>
<td>~210 bp</td>
</tr>
</tbody>
</table>

50 RFU 75–350 bp
Sensitivity study

For the sensitivity study, dilution series of three genomic DNA samples were amplified: 1 ng (three replicates each), 0.5 ng, 0.25 ng, and 0.125 ng (four replicates each). The results were evaluated for mean referenced peak height, degree of linearity between input DNA concentration and peak height, level of allelic dropout at 125 pg, and genotype concordance.

Mean referenced peak height

Mean referenced peak height observations were consistent between all Test and Control mixes (Figure 23) demonstrating equivalent performance (Figure 24).

Figure 23  Sensitivity study: mean referenced peak heights three genomic DNA samples

Figure 24  Sensitivity study: representative electropherograms for Sample 2 amplified using 125 pg input DNA (Y-scale 550 RFU)
DNA concentration and peak height

The calculated slope and $R^2$ values for each of the plotted curves were equivalent, showing comparable relationships between peak height and DNA input amount for the Test and Control mixes (Figure 25).

**Figure 25** Sensitivity study: linear regression plot of combined mean referenced peak height for three genomic DNA samples

Allelic dropout

Allelic dropout was observed only for amplifications of 125 pg where dropout of a single allele was observed for different replicates of Test A Sample 3 (Figure 26 and Figure 27). These results can be explained by stochastic variation and sampling from dilute DNA solutions. Allelic dropout results can therefore be considered equivalent between Test and Control mixes.

**Figure 26** Sensitivity study: electropherogram of 125 pg Sample 3 amplified with Test A mix. One allele at the DYS635 locus in the NED™ dye (yellow) channel is below the analysis threshold of 50 RFU. (Y-scale 300 RFU)
Figure 27 Sensitivity study: electropherogram of 125 pg Sample 3 amplified with Test A mix. One allele at the DYS437 locus in the PET® [Red] dye channel is below the analysis threshold of 50 RFU (Y-scale 500 RFU)
Genotype concordance

Genotypes for Test and Control mixes were 100% concordant (Table 7).

### Table 7  Sensitivity study: genotype concordance

<table>
<thead>
<tr>
<th>DNA Input Amount</th>
<th>Reagent Mix</th>
<th>Genotype Concordance</th>
</tr>
</thead>
<tbody>
<tr>
<td>125 pg</td>
<td>Test A 99%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test B 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test C 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control A 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control B 100%</td>
<td></td>
</tr>
<tr>
<td>250 pg</td>
<td>Test A 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test B 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test C 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control A 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control B 100%</td>
<td></td>
</tr>
<tr>
<td>500 pg</td>
<td>Test A 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test B 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test C 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control A 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control B 100%</td>
<td></td>
</tr>
<tr>
<td>1 ng</td>
<td>Test A 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test B 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Test C 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control A 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control B 100%</td>
<td></td>
</tr>
</tbody>
</table>

Inhibition study

An inhibition series of 1 ng control DNA 007 (consisting of uninhibited control and Humic Acid at a final concentration of 12 ng/µL in replicates of five) was amplified using each of Test and Control mixes. The amount of each inhibitor tested was titrated to cause an approximate 50% reduction in overall peak height of the samples. Results were evaluated for mean referenced peak height, minimum referenced peak height, intracolor balance, and levels of allelic dropout.

Mean referenced peak height, minimum referenced peak height, and intracolor balance

Uninhibited Control DNA 007 Test and Control mixes displayed no significant difference in mean referenced peak height, minimum referenced peak height, and displayed the same changes in intracolor balance as described in the reproducibility study. For the Humic Acid-inhibited DNA, the Test Mixes containing both in-house components showed slightly better results for mean referenced peak height, minimum referenced peak height, and intracolor balance for the FAM™, PET®, and NED™ dye.
channels compared to the Control Mixes or the Test Mix containing the in-house buffer and the enzyme purchased from Roche Molecular Systems. Results for the VIC® dye channel were more comparable across all Test and Control mixes (Figure 28, 29, and 30).

**Figure 28** Inhibition study: mean referenced peak height. Inhibitors: HA = Humic Acid, PRI = Pristine or Uninhibited DNA

![Figure 28](image)

**Figure 29** Inhibition study: minimum referenced peak height. Inhibitors: HA = Humic Acid, PRI = Pristine or Uninhibited DNA

![Figure 29](image)
Inhibition study

**Figure 30** Inhibition study: intracolor balance. Y-axis intracolor balance percentage versus X-axis dye color. Inhibitors: HA = Humic Acid, PRI = Pristine or Uninhibited DNA

Representative electropherograms from the inhibition study are shown in **Figure 31** and 32.

**Figure 31** Inhibition study: representative electropherograms using uninhibited Control DNA 007 (Y-scale 4000 RFU)
Figure 32  Inhibition study: representative electropherograms using Control DNA 007 inhibited with 12 ng/μL Humic Acid (Y-scale 2500 RFU)

Allelic dropout

No allelic dropout events were seen for any Test or Control mixes tested on uninhibited Control DNA 007 and Control DNA 007 inhibited with Humic Acid.

Conclusions

Laboratories can expect to obtain equivalent quality profiles across a wide range of forensic samples when using the Yfiler® Kit containing the AmpliTaq Gold® enzyme and 10X PCR Buffer II manufactured by Life Technologies as compared to the original Yfiler® Kit containing AmpliTaq Gold® enzyme and 10X PCR Buffer II manufactured by Roche Molecular Systems.
Chapter 5  Performance Validation After Buffer and Enzyme Component Replacement

Conclusions
Follow the actions recommended in this appendix to troubleshoot problems that occur during analysis.

**Table 8  Troubleshooting**

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible causes</th>
<th>Recommended actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faint or no signal from both the AmpFSTR® Control DNA 007 and the DNA test samples at all loci</td>
<td>Incorrect volume or absence of PCR Master Mix or Yfiler® Primer Set</td>
<td>Repeat amplification.</td>
</tr>
<tr>
<td></td>
<td>No activation of AmpliTaq Gold® DNA Polymerase</td>
<td>Repeat amplification, making sure to hold reactions initially at 95°C for 11 minutes.</td>
</tr>
<tr>
<td></td>
<td>Master Mix not vortexed thoroughly before aliquoting</td>
<td>Vortex the Master Mix thoroughly.</td>
</tr>
<tr>
<td></td>
<td>Yfiler® Primer Set exposed to too much light</td>
<td>Store the Primer Set protected from light.</td>
</tr>
<tr>
<td></td>
<td>GeneAmp® PCR System malfunction</td>
<td>Refer to the thermal cycler user’s manual and check instrument calibration.</td>
</tr>
<tr>
<td></td>
<td>Use of incorrect thermal cycling parameters</td>
<td>Check the protocol for correct thermal cycling parameters.</td>
</tr>
<tr>
<td></td>
<td>Tubes not seated tightly in the thermal cycler during amplification</td>
<td>Push reaction tubes firmly into contact with block after first cycle. Repeat test.</td>
</tr>
<tr>
<td></td>
<td>Wrong PCR reaction tube</td>
<td>Use MicroAmp® Reaction Tubes with Caps for the GeneAmp® PCR System 9700.</td>
</tr>
<tr>
<td></td>
<td>MicroAmp® Base used with tray/retainer set and tubes in GeneAmp® 9700</td>
<td>Remove MicroAmp® Base from tray/retainer set and repeat test.</td>
</tr>
<tr>
<td></td>
<td>Insufficient PCR product electrokinetically injected</td>
<td>Prepare PCR product as described in Chapter 3, “Perform Electrophoresis” on page 23.</td>
</tr>
<tr>
<td></td>
<td>Degraded formamide</td>
<td>Check the storage of formamide; do not thaw and refreeze multiple times. Try Hi-Di™ Formamide.</td>
</tr>
<tr>
<td>Observation</td>
<td>Possible causes</td>
<td>Recommended actions</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Positive signal from AmpFISTR® Control DNA 007 but partial or no signal from DNA test samples</td>
<td>Quantity of test DNA sample is below assay sensitivity</td>
<td>Quantitate DNA and add 1.0 ng of DNA. Repeat test.</td>
</tr>
<tr>
<td></td>
<td>Test sample contains high concentration of PCR inhibitor (for example, heme compounds, certain dyes)</td>
<td>Quantitate DNA and add minimum necessary volume. Repeat test. Wash the sample in a Centricon®-100 centrifugal filter unit. Repeat test.</td>
</tr>
<tr>
<td></td>
<td>Test sample DNA is severely degraded</td>
<td>If possible, evaluate the quality of DNA sample by running an agarose gel. If DNA is degraded, reamplify with an increased amount of DNA or use the AmpFISTR® MiniFiler™ Kit.</td>
</tr>
<tr>
<td></td>
<td>Dilution of test sample DNA in water or wrong buffer (for example, TE formula with incorrect EDTA concentration)</td>
<td>Redilute DNA using low-TE Buffer (with 0.1 mM EDTA).</td>
</tr>
<tr>
<td></td>
<td>More than one allele present at a locus (except for DYS385a/b)</td>
<td>Presence of exogenous DNA</td>
</tr>
<tr>
<td></td>
<td>Mixed sample</td>
<td>Amplification of stutter product</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Poor peak height balance</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Ordering Information

**Equipment and materials not included**

Table 9 and Table 10 list required and optional equipment and materials not supplied with the Yfiler® Kit. Unless otherwise noted, many of the items are available from major laboratory suppliers (MLS).

#### Table 9  Equipment

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>3100/3100-Avant Genetic Analyzer</td>
<td>Contact your local Life Technologies sales representative</td>
</tr>
<tr>
<td>Applied Biosystems® 3130/3130xl Genetic Analyzer</td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems® 3500/3500xL Genetic Analyzer for Human Identification</td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems® 310 Genetic Analyzer</td>
<td></td>
</tr>
<tr>
<td>GeneAmp® PCR System 9700 with the Silver 96-Well Block</td>
<td>N8050001</td>
</tr>
<tr>
<td>GeneAmp® PCR System 9700 with the gold-plated silver 96-well block</td>
<td>4314878</td>
</tr>
<tr>
<td>Veriti® 96-Well Thermal Cycler</td>
<td>4375786</td>
</tr>
<tr>
<td>Silver 96-well sample block</td>
<td>N8050251</td>
</tr>
<tr>
<td>Gold-plated silver 96-well sample block</td>
<td>4314443</td>
</tr>
<tr>
<td>Tabletop centrifuge with 96-well plate adapters (optional)</td>
<td>MLS</td>
</tr>
</tbody>
</table>

#### Table 10  User-supplied materials

<table>
<thead>
<tr>
<th>Item†</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>AmpFlSTR® Yfiler® PCR Amplification Kit</td>
<td>4427368</td>
</tr>
<tr>
<td><strong>3100 Analyzer materials</strong></td>
<td></td>
</tr>
<tr>
<td>96-well plate septa</td>
<td>4315933</td>
</tr>
<tr>
<td>Reservoir septa</td>
<td>4315932</td>
</tr>
<tr>
<td>3100/3130xl Genetic Analyzer capillary array, 36-cm</td>
<td>4315931</td>
</tr>
<tr>
<td>POP-4® polymer for 3100/3100-Avant Genetic Analyzers</td>
<td>4316355</td>
</tr>
<tr>
<td>3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well</td>
<td>4316471</td>
</tr>
<tr>
<td>GeneScan™ 500 LIZ® Size Standard</td>
<td>4322682</td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>GeneScan™ 600 LIZ® Size Standard v2.0</td>
<td>4408399</td>
</tr>
<tr>
<td>Running Buffer, 10X</td>
<td>402824</td>
</tr>
<tr>
<td>Hi-Di™ Formamide</td>
<td>4311320</td>
</tr>
</tbody>
</table>
### Ordering Information

*Equipment and materials not included*

<table>
<thead>
<tr>
<th>Item†</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS-33 Matrix Standard Kit [Dye Set G5]</td>
<td>4345833</td>
</tr>
<tr>
<td>MicroAmp® Optical 96-well reaction plate</td>
<td>N8010560</td>
</tr>
<tr>
<td>250-µL glass syringe [array-fill syringe]</td>
<td>4304470</td>
</tr>
<tr>
<td>5.0-mL glass syringe (polymer-reserve syringe)</td>
<td>628-3731</td>
</tr>
</tbody>
</table>

For a complete list of parts and accessories for the 3100/3100-Avant instrument, refer to Appendix B of the 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Pub no. 4335393).

### 3130xl Analyzer materials

<table>
<thead>
<tr>
<th>Item†</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-well plate septa</td>
<td>4315933</td>
</tr>
<tr>
<td>Reservoir septa</td>
<td>4315932</td>
</tr>
<tr>
<td>3100/3130xl Genetic Analyzer capillary array, 36-cm</td>
<td>4315931</td>
</tr>
<tr>
<td>POP-4® polymer for 3130/3130xl Genetic Analyzers</td>
<td>4352755</td>
</tr>
<tr>
<td>3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well</td>
<td>4316471</td>
</tr>
<tr>
<td>GeneScan™ 500 LIZ® Size Standard</td>
<td>4322682</td>
</tr>
<tr>
<td>OR</td>
<td>4408399</td>
</tr>
<tr>
<td>GeneScan™ 600 LIZ® Size Standard v2.0</td>
<td>4408399</td>
</tr>
<tr>
<td>Running Buffer, 10X</td>
<td>402824</td>
</tr>
<tr>
<td>DS-33 Matrix Standard Kit [Dye Set G5]</td>
<td>4345833</td>
</tr>
<tr>
<td>MicroAmp® Optical 96-well reaction plate</td>
<td>N8010560</td>
</tr>
<tr>
<td>Hi-Di™ Formamide</td>
<td>4311320</td>
</tr>
</tbody>
</table>

For a complete list of parts and accessories for the 3130/3130xl instrument, refer to Appendix A of the Applied Biosystems® 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub no. 4352716).

### 3500/3500xL Analyzer materials

<table>
<thead>
<tr>
<th>Item†</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anode buffer container (ABC)</td>
<td>4393927</td>
</tr>
<tr>
<td>Cathode buffer container (CBC)</td>
<td>4408256</td>
</tr>
<tr>
<td>POP-4® polymer [960 samples] for 3500/3500xL Genetic Analyzers</td>
<td>4393710</td>
</tr>
<tr>
<td>POP-4® polymer [384 samples] for 3500/3500xL Genetic Analyzers</td>
<td>4393715</td>
</tr>
<tr>
<td>Conditioning reagent</td>
<td>4393718</td>
</tr>
<tr>
<td>8-Capillary array, 36 cm for 3500 Genetic Analyzers</td>
<td>4404683</td>
</tr>
<tr>
<td>24-Capillary array, 36 cm for 3500xL Genetic Analyzers</td>
<td>4404687</td>
</tr>
<tr>
<td>96-well retainer &amp; base set [Standard] 3500/3500xL Genetic Analyzers</td>
<td>4410228</td>
</tr>
<tr>
<td>8-Tube retainer &amp; base set [Standard] for 3500/3500xL Genetic Analyzers</td>
<td>4410231</td>
</tr>
<tr>
<td>8-Strip Septa for 3500/3500xL Genetic Analyzers</td>
<td>4410701</td>
</tr>
<tr>
<td>96-Well Septa for 3500/3500xL Genetic Analyzers</td>
<td>4412614</td>
</tr>
<tr>
<td>Septa Cathode Buffer Container, 3500 series</td>
<td>4410715</td>
</tr>
<tr>
<td>GeneScan™ 600 LIZ® Size Standard v2.0</td>
<td>4408399</td>
</tr>
<tr>
<td>DS-33 Matrix Standard Kit [Dye Set G5]</td>
<td>4345833</td>
</tr>
</tbody>
</table>

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems® 3500/3500xL Genetic Analyzer User Guide (Pub no. 4401661)
### 310 Analyzer materials

<table>
<thead>
<tr>
<th>Item</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>310 DNA Analyzer capillary array, 47-cm</td>
<td>402839</td>
</tr>
<tr>
<td>0.5 mL sample tray</td>
<td>5572</td>
</tr>
<tr>
<td>96-well tray adaptor (for 9700 thermal cycler trays)</td>
<td>4305051</td>
</tr>
<tr>
<td>GeneScan™ 500 LIZ® Size Standard OR</td>
<td>4322682</td>
</tr>
<tr>
<td>GeneScan™ 600 LIZ® Size Standard v2.0</td>
<td>4408399</td>
</tr>
<tr>
<td>Running Buffer, 10X</td>
<td>4335643</td>
</tr>
<tr>
<td>Genetic analyzer septa retainer clips for 96-tube sample tray</td>
<td>402866</td>
</tr>
<tr>
<td>Genetic analysis sample tubes (0.5-mL)</td>
<td>401957</td>
</tr>
<tr>
<td>Septa for 0.5-mL sample tubes</td>
<td>401956</td>
</tr>
<tr>
<td>DS-33 Matrix Standard Set (6-FAM®, VIC®, NED®, PET®, and LIZ® dyes) for 310/377 systems</td>
<td>4318159</td>
</tr>
<tr>
<td>MicroAmp® 8-tube strip, 0.2-mL</td>
<td>N8010580</td>
</tr>
<tr>
<td>MicroAmp® 96-well base (holds 0.2-mL reaction tubes)</td>
<td>N8010531</td>
</tr>
<tr>
<td>MicroAmp® 96-well full plate cover</td>
<td>N8010550</td>
</tr>
<tr>
<td>MicroAmp® 96-well tray/retainer set</td>
<td>403081</td>
</tr>
<tr>
<td>POP-4® polymer for the 310 Genetic Analyzer</td>
<td>402838</td>
</tr>
</tbody>
</table>

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the 310 Genetic Analyzer User Guide (Pub no. 4317588).

### PCR Amplification

<table>
<thead>
<tr>
<th>Item</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp® 96-well tray</td>
<td>N8010541</td>
</tr>
<tr>
<td>MicroAmp® reaction tube with cap, 0.2-mL</td>
<td>N8010540</td>
</tr>
<tr>
<td>MicroAmp® 8-tube strip, 0.2-mL</td>
<td>N8010580</td>
</tr>
<tr>
<td>MicroAmp® 8-cap strip</td>
<td>N8010535</td>
</tr>
<tr>
<td>MicroAmp® 96-well tray/retainer set</td>
<td>403081</td>
</tr>
<tr>
<td>MicroAmp® 96-well base</td>
<td>N8010531</td>
</tr>
<tr>
<td>MicroAmp® clear adhesive film</td>
<td>4306311</td>
</tr>
<tr>
<td>MicroAmp® optical adhesive film</td>
<td>4311971</td>
</tr>
<tr>
<td>MicroAmp® optical 96-well reaction plate</td>
<td>N8010560</td>
</tr>
</tbody>
</table>

### Other user-supplied materials

<table>
<thead>
<tr>
<th>Item</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi-Di™ Formamide, 25-mL</td>
<td>4311320</td>
</tr>
<tr>
<td>Aerosol resistant pipette tips</td>
<td>MLS</td>
</tr>
<tr>
<td>Microcentrifuge tubes</td>
<td>MLS</td>
</tr>
<tr>
<td>Pipettors</td>
<td>MLS</td>
</tr>
<tr>
<td>Tape, labeling</td>
<td>MLS</td>
</tr>
<tr>
<td>Tube, 50-mL Falcon</td>
<td>MLS</td>
</tr>
<tr>
<td>Tube decapper, autoclavable</td>
<td>MLS</td>
</tr>
<tr>
<td>Deionized water, PCR grade</td>
<td>MLS</td>
</tr>
</tbody>
</table>
### Ordering Information

*Equipment and materials not included*

<table>
<thead>
<tr>
<th>Item†</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tris-HCl, pH 8.0</td>
<td>MLS</td>
</tr>
<tr>
<td>EDTA, 0.5 M</td>
<td>MLS</td>
</tr>
<tr>
<td>Vortex</td>
<td>MLS</td>
</tr>
</tbody>
</table>

† For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are using the AmpFISTR® Yfiler® PCR Amplification Kit for:


The sensitivity of the Yfiler® Kit (and other PCR-based tests) enables amplification of minute quantities of DNA, necessitating precautions to avoid contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by human DNA. Wear gloves at all times and change them frequently. Close sample tubes when not in use. Limit aerosol dispersal by handling sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all precautions and care necessary for using PCR technology.

PCR setup work area

**IMPORTANT!** These items should never leave the PCR Setup Work Area.

- Calculator
- Gloves, disposable
- Marker pen, permanent
- Microcentrifuge
- Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for Master Mix preparation)
- Microcentrifuge tube rack
- Pipette tips, sterile, disposable hydrophobic filter-plugged
- Pipettors
Amplified DNA work area

- Tube decapper, autoclavable
- Vortex

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
- GeneAmp® PCR System 9700 with the Silver 96-Well Block
- GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The Yfiler® Kit is not validated for use with the GeneAmp® PCR System 9700 with the Aluminium 96-Well Block. Use of this thermal cycling platform may adversely affect performance of the Yfiler® Kit.

- Veriti® 96-Well Thermal Cycler
WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user documentation may result in personal injury or damage to the instrument or device. Ensure that anyone using this product has received instructions in general safety practices for laboratories and the safety information provided in this document.

- Before using an instrument or device, read and understand the safety information provided in the user documentation provided by the manufacturer of the instrument or device.
- Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use appropriate personal protective equipment (gloves, gowns, eye protection, etc). To obtain SDSs, see the “Documentation and Support” section in this document.
Chemical safety

**WARNING! GENERAL CHEMICAL HANDLING.** To minimize hazards, ensure laboratory personnel read and practice the general safety guidelines for chemical usage, storage, and waste provided below, and consult the relevant SDS for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see the “Documentation and Support” section in this document.
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing).
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood).
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the SDS.
- Handle chemical wastes in a fume hood.
- Ensure use of primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
- After emptying a waste container, seal it with the cap provided.
- Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
- Ensure that the waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.
- **IMPORTANT!** Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

Biological hazard safety

**WARNING! Potential Biohazard.** Depending on the samples used on this instrument, the surface may be considered a biohazard. Use appropriate decontamination methods when working with biohazards.
WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective equipment, which includes but is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves. All work should be conducted in properly equipped facilities using the appropriate safety equipment (for example, physical containment devices). Individuals should be trained according to applicable regulatory and company/institution requirements before working with potentially infectious materials. Read and follow the applicable guidelines and/or regulatory requirements in the following:

In the U.S.:
- U.S. Department of Health and Human Services guidelines published in Biosafety in Microbiological and Biomedical Laboratories found at: [www.cdc.gov/biosafety](http://www.cdc.gov/biosafety)
- Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR§1910.1030), found at: [www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html](http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html)
- Your company’s/institution’s Biosafety Program protocols for working with/handling potentially infectious materials.
- Additional information about biohazard guidelines is available at: [www.cdc.gov](http://www.cdc.gov)

In the EU:
### Related documentation

<table>
<thead>
<tr>
<th>Document title</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>AmpFSTR® Yfiler® PCR Amplification Kit: Human Identification: Application Note</td>
<td></td>
</tr>
<tr>
<td>3100/3100-Avant Data Collection v2.0 User Guide</td>
<td>4347102</td>
</tr>
<tr>
<td>3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 User Bulletin</td>
<td>4350218</td>
</tr>
<tr>
<td>3100 Genetic Analyzer User Manual [Data Collection v1.1]</td>
<td>4315834</td>
</tr>
<tr>
<td>3100/3100-Avant Genetic Analyzers Protocols for Processing AmpFSTR® PCR Amplification Kit PCR Products User Bulletin</td>
<td>4332345</td>
</tr>
<tr>
<td>Applied Biosystems® 3130/3100x Genetic Analyzers Using Data Collection Software v3.0 User Bulletin</td>
<td>4363787</td>
</tr>
<tr>
<td>Applied Biosystems® 3130/3130xl Genetic Analyzers Getting Started Guide</td>
<td>4352715</td>
</tr>
<tr>
<td>Applied Biosystems® 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide</td>
<td>4352716</td>
</tr>
<tr>
<td>Applied Biosystems® 3130/3130xl Genetic Analyzers Quick Reference Card</td>
<td>4362825</td>
</tr>
<tr>
<td>Applied Biosystems® 3130/3130xl Genetic Analyzers AB Navigator Software Administrator Guide</td>
<td>4359472</td>
</tr>
<tr>
<td>Applied Biosystems® 3130/3100x DNA Analyzers User Guide</td>
<td>4331468</td>
</tr>
<tr>
<td>Applied Biosystems® 3500/3500xL Genetic Analyzer Quick Reference Card</td>
<td>4401662</td>
</tr>
<tr>
<td>Applied Biosystems® 3500/3500xL Genetic Analyzer User Guide, Data Collection v1.0</td>
<td>4401661</td>
</tr>
<tr>
<td>Applied Biosystems® 3500/3500xL Genetic Analyzer User Bulletin: Solutions to issues related to software, data, hardware, and consumables</td>
<td>4445098</td>
</tr>
</tbody>
</table>

**Note:** Additional user bulletins may be available at [www.lifetechnologies.com](http://www.lifetechnologies.com)
Document title | Part number
---|---
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Quick Reference Guide | 4402094
GeneMapper® ID-X Software Version 1.2 Reference Guide | 4426481
GeneMapper® ID-X Software Version 1.2 Quick Reference Guide | 4426482

Portable document format (PDF) versions of this guide and the documents listed above are available at [www.lifetechnologies.com](http://www.lifetechnologies.com).

**Note:** To open the user documentation available from our web site, use the Adobe® Acrobat® Reader® software available from [www.adobe.com](http://www.adobe.com).

**Obtain SDSs**

Safety Data Sheets (SDSs) are available from [www.lifetechnologies.com/sds](http://www.lifetechnologies.com/sds).

**Note:** For the SDSs of chemicals not distributed by Life Technologies, contact the chemical manufacturer.

**Obtain support**

For HID support:

- **In North America** – Send an email to HIDTechSupport@lifetech.com, or call 888-821-4443 option 1.
- **Outside North America** – Contact your local support office.

For the latest services and support information for all locations, go to:

[www.lifetechnologies.com](http://www.lifetechnologies.com)

At the website, you can:

- Access worldwide telephone and fax numbers to contact Technical Support and Sales facilities
- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Search for user documents, SDSs, vector maps and sequences, application notes, formulations, handbooks, certificates of analysis, citations, and other product support documents
- Obtain information about customer training
- Download software updates and patches
Limited Product Warranty

Life Technologies and/or its affiliate(s) warrant their products as set forth in the Life Technologies' General Terms and Conditions of Sale found on Life Technologies' website at www.lifetechnologies.com/termsandconditions. If you have any questions, please contact Life Technologies at www.lifetechnologies.com/support.


Bibliography
**Index**

**Numerics**
- 310 instrument 29
- 3130/3130xl instrument 25
- 3500/3500xL instrument 27

**A**
- A nucleotide, addition by AmpliTaq Gold to 3’ end of amplicon 78
- agarose gel, using to examine DNA 85
- allele frequencies in the population databases 89
- allelic ladder
  - about 18
  - precision 69
  - profile 12
  - requirements for accurate genotyping 23
  - volume per reaction 26, 28, 30
- amplification
  - differential amplification of loci 85
  - loci 12
- AmpliTaq Gold DNA Polymerase, catalyzing the addition of a 3’ A nucleotide 78

**B**
- bins
  - check version 50
  - import 33, 50
- biohazard safety 112
- buffer, new 92

**C**
- chemical safety 112
- contents of kit 18
- control DNA 007 14, 18
- control DNA 9947A 18

**D**
- Data Collection Software, overview 16
- data, analysis 89

- degraded DNA 85
- developmental validation 66
- differential amplification of loci 85
- discriminatory capacity 90

**DNA**
- control, about 18
- effect of DNA quantity on results 83
- how degraded DNA affects which loci amplify 85
- negative-control reaction 21
- positive-control reaction 21
- quantification 19
- quantification methods 20
- sample preparation 21
- test sample 21
- using agarose gel analysis to examine the DNA 85
- documentation, related 115

**E**
- effect of inhibitors 84
- electropherogram
  - addition of a 3’ A nucleotide 78
  - stutter peak 76
- electrophoresis
  - Data Collection Software 25, 27, 29
  - preparing samples on the 310 instrument 29
  - preparing samples on the 3100/3100-Avant or 3130/3130xl instrument 26
  - preparing samples on the 3500/3500xL instrument 27
  - reagents and parts 25, 27, 29
  - references 25, 27, 29
  - run module 25, 27, 29
  - set up 25, 27, 29
- emission spectra 17
- enzyme, new 92
- equipment, not included with kit 105
- evidence, exclusion of suspects 88
Index

F
fluorescent dyes 16

G
gels 85
gene diversity values 89
GeneMapper ID Software
analyze project 44
create analysis method 37
create size standard 42, 60
examine and edit project 45
import panels and bins 33
overview 16, 31
set up 32
GeneMapper ID-X Software
analyze project 62
check version of panels, bins, and stutter 49, 50
create analysis method 55
examine and edit project 63
overview 16, 48
set up 49
GeneScan size standard
about 18
dye label 16
volume per reaction 26, 27, 29
genetics
allele frequencies 89
populations and samples used in studies 89
genotype
determining 69
exclusion of suspects 88

H
hematin, effect on DNA samples 84
Hi-Di formamide, volume per reaction 26, 27, 29

I
import
HID size standard 42, 60
panels and bins 33
panels, bins, and stutter 50
instrumentation
310 genetic analyzer 16, 29
3100/3100-Avant genetic analyzer 16, 25
3130/3130xl genetic analyzer 16, 25
3500/3500xL genetic analyzer 16, 25, 27
software compatibility 16

K
kit
allelic ladder 18
amplification 11
contents 18
control DNA 18
description 11
DNA polymerase 18, 21
fluorescent dyes 16
loci amplification 12
PCR reaction mix 18, 21
primers 11, 18, 20
reagents 18
supported instruments 11
thermal cyclers for use with 110

L
limited product warranty 117
LIZ size standard
about 18
volume per reaction 26, 27, 29
loci
allele frequencies in the population databases 89
chromosomal location 12
differential amplification 85
dye label 12
lack of amplification, effect of DNA quantity on results 83
population data, allele frequencies 89
population data, samples used in studies 89
locus. See loci
low-TE buffer 19

M
materials and equipment
included in kit 18
not included with kit 105
mixed samples 86
multicomponent analysis 16

N
negative control, sample preparation 21
Index

O
operating systems 16, 25, 27, 29

P
panels
check version 49, 50
import 33, 50
PCR
amplification of tetranucleotide STR loci (stutter peak) 76
inhibitor causing lack of amplification 84
performing 22
setup 109
thermal cycling conditions, programming 22
PCR work areas 105, 109
population genetics
allele frequencies 89
populations and samples used in the studies 89
positive control, sample preparation 21
primers, volume per reaction 21

Q
quantification, DNA 19

R
reaction mix, volume per reaction 21
reactions, preparing for PCR 21
reagents
not included with kit 105
user supplied 19
references 119
run module, electrophoresis 25, 27, 29

S
safety
biohazard 112
chemical 112
Safety Data Sheets (SDSs), obtaining 116
sample preparation 21
DNA negative control 21
DNA positive control 21
standards 18
software, instrument compatibility 16
stutter
check version 49, 50
import 50
stutter peak or product 76
support, obtaining 116

T
technical support 116
thermal cyclers
for use with kit 110
programming conditions 22
training, information on 116
troubleshooting 103

U
user-supplied reagents 19

V
validation
accuracy, precision, reproducibility 69
characterization of loci 80
developmental 66
experiments to evaluate 66
importance of 66
mixture studies 86
mutation rate 90
population data 88
sensitivity 83
species specificity 81
stability 84
thermal cycler parameters 67

W
warranty 117
work area
amplified DNA 110
PCR setup 109
setup and lab design 109
workflow overview 15
Index

AmpFSTR® Yfiler® PCR Amplification Kit User Guide